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Preface

How to Use This Guide

Purpose of This
Guide

This guide provides recommended schedules and procedures for maintaining the 
Applied Biosystems 7900HT Fast Real-Time PCR System (7900HT Fast System). This 
guide also includes troubleshooting information for the maintenance procedures.

Audience This guide is intended for: 

• Personnel who maintain the 7900HT Fast System hardware
• System Administrators who maintain the 7900HT Fast System software
• Personnel running experiments

Assumptions For hardware maintenance, this guide assumes that you have:

• Familiarity with the Microsoft Windows® XP operating system. 
• Knowledge of general techniques for handling DNA samples and preparing them 

for PCR. 

For software maintenance, this guide assumes that you have:

• Familiarity with the Microsoft Windows® XP operating system. 
• A general understanding of hard drives and data storage, file transfers, and copying 

and pasting.
• Networking experience, if you want to integrate the 7900HT Fast System into your 

existing laboratory data flow

Text Conventions This guide uses the following conventions: 

• Bold indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

• Italic text indicates new or important words and is also used for emphasis. For 
example:
Before analyzing, always prepare fresh matrix.

• A right arrow bracket (>) separates successive commands you select from a drop-
down or shortcut menu. For example:
Select File > Open.

User Attention
Words

The following user attention words appear in Applied Biosystems user documentation. 
Each word implies a particular level of observation or action as described below:

Note – Provides information that may be of interest or help but is not critical to the use 
of the product.
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IMPORTANT! – Provides information that is necessary for proper instrument operation, 
accurate chemistry kit use, or safe use of a chemical.

 Indicates a potentially hazardous situation that, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe practices.

 Indicates a potentially hazardous situation that, if not avoided, could 
result in death or serious injury.

Safety Follow specific safety practices when using this instrument. For safety guidelines, refer 
to the “Safety and EMC Compliance” section in the Applied Biosystems 7900HT Fast 
Real-Time PCR System Site Preparation Guide (PN 4351923).

For any chemical manufactured or distributed by Applied Biosystems, you can obtain 
the MSDS from Applied Biosystems. This service is available free 24 hours a day. To 
obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part 
number, or other information that appears in the MSDS of interest. Select the 
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the 
following:
• Open – To view the document
• Print Target – To print the document
• Save Target As – To download a PDF version of the document to a destination 

that you choose

For the MSDSs of chemicals not distributed by Applied Biosystems, contact the 
chemical manufacturer.

How to Obtain More Information

Related
Documentation

For more information about using the 7900HT Fast System, refer to:

• Sequence Detection Systems Software version 2.3 Online Help (SDS Online Help)
• Applied Biosystems 7900HT Fast Real-Time PCR System Site Preparation Guide 

(PN 4351923)
• Applied Biosystems 7900HT Fast Real-Time PCR System Allelic Discrimination 

Getting Started Guide (PN 4364015)
• Applied Biosystems 7900HT Fast Real-Time PCR System Absolute Quantitation 

Using Standard Curve Getting Started Guide (PN 4364014)
• Applied Biosystems 7900HT Fast Real-Time PCR System Plus-Minus Getting 

Started Guide (PN 4364017)
• Applied Biosystems 7900HT Fast Real-Time PCR System Relative Quantitation 

Using Comparative CT Getting Started Guide (PN 4364016)
• Real-Time PCR Systems Chemistry Guide (PN 4348358)

http://www.appliedbiosystems.com
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• SDS Enterprise Database for the Applied Biosystems 7900HT Fast Real-Time PCR 
System Administrators Guide (PN 4351669)

• TaqMan® Low Density Array Getting Started Guide (PN 4319399)

Send Us Your
Comments

Applied Biosystems welcomes your comments and suggestions for improving its user 
documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

How to Obtain Support
To contact Applied Biosystems Technical Support from North America by telephone, 
call 1.800.762.4001.

For the latest services and support information for all locations, go to 
http://www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

• Obtain worldwide telephone and fax numbers to contact Applied Biosystems 
Technical Support and Sales facilities

• Search through frequently asked questions (FAQs)
• Submit a question directly to Technical Support
• Order Applied Biosystems user documents, MSDSs, certificates of analysis, and 

other related documents
• Download PDF documents
• Obtain information about customer training
• Download software updates and patches

mailto:techpubs@appliedbiosystems.com
http://www.appliedbiosystems.com


Preface
How to Obtain Support

viii 7900HT Fast System Maintenance and Troubleshooting Guide



7900HT Fast System Maintenance and Troubleshooting Guide 1

Notes

1

Chapter 1

Performing Calibration and
Verification Runs

Performing
Calibration and
Verification Runs

Recommended
Run Schedule

Performing a
Background Calibration

Performing an
Instrument Verification Run

Performing a
Pure Dye Calibration

Maintaining the
Computer and
Software

Maintaining the
Automation
Accessory

Flags and Filtering

Troubleshooting
Chemistry and
Assay Runs

Maintaining
the 7900HT
Instrument
Hardware

See page 32

See page 17

See page 2

See page 3



Chapter 1 Performing Calibration and Verification Runs
Recommended Run Schedule

2 7900HT Fast System Maintenance and Troubleshooting Guide

Notes

Recommended Run Schedule
To ensure optimal performance of your 7900HT Fast System, perform the calibration 
and verification runs as indicated in the table below.

Schedule Run Type

Semi-annually Perform a background calibration (see page 3) 

IMPORTANT! You must also perform a background calibration 
before performing a pure dye calibration and after installing a new, 
uncalibrated sample block.

Perform a pure dye calibration (see page 17)

IMPORTANT! You must also perform a pure dye calibration 
before performing an instrument verification run and after installing 
a new, uncalibrated sample block.

Perform an instrument verification run (see page 32) 

6 Months

January
Su M T W Th F S Su M T W Th F S

July
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Performing a Background Calibration

Overview

When to Perform Applied Biosystems recommends performing a background calibration:

• Every 6 months, or as often as needed depending on instrument use
• Before performing a pure dye calibration (see page 17)
• After installing a new, uncalibrated sample block (see page 53)

You can also perform background calibrations to detect and troubleshoot sample block 
contamination.

About the
Background

Calibration

A background calibration measures the level of ambient fluorescence in the 7900HT 
instrument. During the run, the 7900HT instrument performs a continuous scan of a 
background plate (which contains PCR buffer or deionized water) for 2 minutes at 
60 °C. Afterwards, the SDS software averages the spectrum recorded during the run and 
extracts the resulting spectral component to a calibration file. The SDS software uses the 
calibration file during subsequent runs to remove the background signal from the run 
data.

About the
Background
Component

Fluorescence collected by the 7900HT Fast System includes a fluorescent signal 
inherent to the system, commonly referred to as background fluorescence. This 
background component is a composite signal found in all spectral data that consists of 
fluorescence from several sources, including: the background electronic signal, the 
sample block, the water inside the consumable, and the consumable itself. Because the 
background fluorescence can interfere with the precision of the data collected by the 
7900HT System, the instrument is engineered to minimize the background signal; 
additionally, the SDS software algorithmically eliminates the background signal from 
each fluorescent sample to maximize the instrument’s sensitivity.
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Before You Begin

Time Required 30 minutes

Materials
Required

You need the materials listed below to perform this procedure.

For 384- or 96-Well Sample Blocks

For the TaqMan Low Density Array Block

Powder-free gloves and safety goggles

Background plate from one of the following 
calibration kits:

• Sequence Detection Systems 384-Well 
Spectral Calibration Kit (PN 4323977)

• ABI PRISM® 7900HT Sequence Detection 
Systems 96-Well Spectral Calibration Kit 
(PN 4328639)

• 7900HT System Fast 96-Well Spectral 
Calibration Kit (PN 4351653)

Centrifuge, with plate adapter

Powder-free gloves and safety goggles

TaqMan® Low Density Array Spectral 
Calibration Kit (PN 4362745). Use:

• The tube of background solution

• One empty TLDA

7900HT System Fast 96-Well
Spectral Calibration Kit

Caution!

May cause eye, skin, and respiratory

track irritation.

Made in USA

Part No: 4351653

Lot No: 0409003

Store at -15°C to -25°C

7900HT TaqMan®  Low

Density Empty Array

Part No:

Lot No:

For Research Use Only.

Not for use in

diagnostic procedures

0000001

1000002

Micro Fluidic Card

Spectral Calibration Reagents

Made in USA

Part No:

Lot No:

0000001

1000002
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Workflow To perform the background calibration:

1. Obtain the tools and materials required (see pages 4 and 5).

2. Prepare the background plate (see page 6) or background TLDA (see page 9).

3. Create a plate document (see page 10).

4. Run the background plate or background TLDA (see page 12).

5. Analyze the background data (see page 14).

Troubleshooting If you experience problems with the background calibration, see “Troubleshooting 
Background Calibrations” on page 15.

Vortex

Micropipettors and pipet tips:

• Rainin F-100 micropipette (100-µL)

• Rainin Fine Point pipet tips (100-µL)

Centrifuge (For more information, see the 
TaqMan® Low Density Array Getting Started 
Guide.)

TaqMan® Low Density Array Sealer (For more 
information, see the TaqMan® Low Density 
Array Getting Started Guide.)

GR2170

G
R

21
72
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Preparing the Background Plate

1. Retrieve the calibration kit from the freezer and 
remove the packaged background plate from 
within it. 

2. Return the calibration kit to the freezer.

3. Allow the background plate to warm to room 
temperature (approximately 5 min).

4. Remove the background plate from its 
packaging.

IMPORTANT! Do not discard the packaging for 
the background plate. The background plate can 
be used repeatedly if it is stored in its original 
packaging sleeve.

5. Briefly centrifuge the background plate in a 
centrifuge with plate adapter.

IMPORTANT! Wear powder-free 
gloves when you handle the 
background plate.

>00:05:00Ambient

00:00:05<1500×g
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6. Verify that the liquid in each well of the 
background plate is positioned at the bottom of 
the well. If not, centrifuge the plate again at a 
higher rpm and for a longer period of time.

IMPORTANT! Do not allow the bottom of the 
background plate to become dirty. Fluids and 
other contaminants that adhere to the bottom of 
the plate can contaminate the sample block and 
cause an abnormally high background signal.

7. Proceed to “Creating a Background Plate 
Document” on page 10.

Correct Incorrect

Sample is 
positioned at 
bottom of well.

The plate has not been centrifuged 
with enough force, or has not been 
centrifuged for enough time.
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Creating a Background Plate

If a background plate from a calibration kit is not available, you can create one to perform the background calibration by 
following the procedure below. Whenever possible, Applied Biosystems recommends the use of the background plate 
included with the calibration kit because it contains a PCR buffer that more accurately models the reagents used for PCR, 
and therefore produces better calibration data.

Materials Required 

Note: Reaction plate options are:

• 384-Well Clear Optical Reaction Plate (standard 
384-well reaction plate)

• MicroAmp® 96-Well Optical Reaction Plate 
(standard 96-well reaction plate)

• Optical 96-Well Fast Thermal Cycling Plate 
(Fast 96-well reaction plate)

To create the background plate:

1. Remove a reaction plate from its box and place it on a clean, dry 
surface.

2. Aliquot deionized water to each well of the reaction plate, as 
follows:

– 20 µL per well for a standard 384-well or Fast 96-well 
reaction plate

– 50 µL per well for a standard 96-well reaction plate

3. Seal the plate:

– For standard 384-well or Fast 96-well reaction plates, use 
only an optical adhesive cover.

– For standard 96-well reaction plates, use an optical 
adhesive cover or optical flat caps.

4. Continue with step 5 on page 6.

Reaction plate
(see note at right)

Optical adhesive cover 
or Optical Caps 
(PN 4323032)

Deionized 
water

Pipettor, 100 to 
200-µL (with pipet 
tips) Safety glasses

Powder-free 
gloves

IMPORTANT! Wear powder-free 
gloves while creating the background 
plate.

Pipet deionized water 
to each well

Seal the plate
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Preparing the Background TLDA

1. Retrieve the calibration kit from the freezer and 
remove:

• The tube of background solution
• One empty TLDA

2. Return the calibration kit to the freezer.

3. Allow the background solution to thaw at room 
temperature.

4. When the solution has thawed, vortex the tube.

5. Load the background solution into the empty 
TLDA, loading 100 µL of solution per fill 
reservoir.

Note: For detailed loading procedures see the 
TaqMan® Low Density Array Getting Started 
Guide.

6. Centrifuge and seal the background TLDA.

Note: For centrifuging and sealing procedures 
see the TaqMan® Low Density Array Getting 
Started Guide.

7. Proceed to “Creating a Background Plate 
Document” on page 10.

Background 
solution

Empty TLDA

Calibration 
reagents box

>00:05:00Ambient
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Creating a Background Plate Document

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. If the login option is enabled, the Login dialog 
box appears. Enter your User Name and 
Password, then click OK.

Note: If the login option is not enabled, no 
Login dialog box appears. Skip to step 3 below.

3. Click  (or select File New).

4. Complete the New Document dialog box: 
a. Assay – Select Background.
b. Container – Select the appropriate format.
c. Template – Select the appropriate template, 

as described in the table below:

d. If the background plate or background 
TLDA is labeled with a barcode, click the 
Barcode field, then type in or scan the 
barcode number.

e. Click . The software creates and 
opens a plate document with the attributes 
for a background calibration. 

IMPORTANT! Do not modify the 
background plate document. The method 
for a background calibration is coded into 
the SDS software and consists of a single 

4a

4b

4c

4d
4e

For Container... Select Template...

384 Wells Clear Plate Blank Template

96 Wells Clear Plate (for 
a Standard 96-Well 
Sample Block)

Blank Template

96 Wells Clear Plate (for 
a Fast 96-Well Sample 
Block)

Fast 96 Well Background Plate.sdt

384 Wells TaqMan Low 
Density Array

TaqMan Low Density Array 
Background Plate.sdt
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hold at 60 °C for 2 min. Because the plate 
contains only PCR buffer or deionized 
water, the plate document does not require 
sample or detector labels.

5. Save the plate document:
a. Click  (or select File Save) to open the 

Save As dialog box.
b. If the Save in field does not display SDS 

Documents, navigate to Applied 
Biosystems SDS Documents.

c. In the File name field, type in an appropriate 
file name, as described in the table below.

d. Select SDS 7900HT Document (*.sds) 
from the Files of type drop-down list.

e. Click . The software saves the plate 
document.

6. Continue with “Running the Background Plate or 
Background TLDA” on page 12.

5b. This should be 
SDS Documents

5e
5c

5d

For Container... Type...

384 Wells Clear Plate Background_<date in MMDDYY 
format>

For example, the file name for a plate 
run on May 31, 2005, would be: 
Background_053105.

96 Wells Clear Plate (for 
a Standard 96-Well 
Sample Block)

Background_<date in MMDDYY 
format>

For example, the file name for a plat run 
on May 31, 2005, would be: 
Background_053105.

96 Wells Clear Plate (for 
a Fast 96-Well Sample 
Block)

FastBackground_Plate_<date in 
MMDDYY format>

For example, the file name for a Fast 
plate run on May 31, 2005, would be: 
FastBackground_053105.

384 Wells TaqMan Low 
Density Array

Background<date in MMDDYY 
format>_TLDA

For example, the file name for a 
background TLDA run on 
May 31, 2005, would be: 
Background_053105_TLDA.
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Running the Background Plate or Background TLDA

1. In the background plate document, select the 
Instrument Real-Time tabs.

2. Click . The instrument tray rotates to 
the OUT position.

3. Place the background plate or background TLDA 
into the instrument tray as shown.

IMPORTANT! The background plate or TLDA 
must be oriented so that the A1 position matches 
the A1 label on the instrument tray.

4. Click . The instrument tray rotates to 
the IN position and performs the background 
calibration. 

Note: Before starting the run, the instrument 
may pause (up to 15 min) to bring the heated 
cover to the appropriate temperature.

5. When the background calibration is complete 
and the Run Complete dialog box appears, 
click  to close the dialog box.

1

2

Well A1

Barcode

Standard 384-well reaction plate
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6. Click , then remove the background 
plate or background TLDA from the instrument 
tray.

 PHYSICAL INJURY 
HAZARD. During instrument operation, the 
sample block can be heated as high as 100 °C. 
Before removing the background plate or 
background TLDA, be sure to wait until the 
sample block reaches room temperature.

7. Place the background plate or background TLDA 
back inside its packaging, then return it to the 
calibration kit in the freezer.

IMPORTANT! Do not discard the background 
plate or background TLDA. If you store it in its 
original packaging, you can use the background 
plate or background TLDA for up to 6 months 
after you open it.

8. Continue with “Analyzing the Background Data” 
on page 14.

-20 to -25 °C
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Analyzing the Background Data

When you analyze the background data, the SDS 
software extracts the calibration values from the 
background plate document, then provides pass/fail 
information. After extraction, the SDS software stores 
the data as part of the calibration file located in the 
Calibration subdirectory of the SDS directory.

To analyze the background data:

1. In the Plate Grid of the background plate 
document, click the box above the A label to 
select all wells.

2. Select Analysis Extract Background.
The software attempts to extract the background 
signal and displays the success of the extraction 
in a dialog box.

3. If the software displays:

Calibration Update Complete – The analysis is 
successful. The raw spectra read from the 
background plate conform to acceptable limits.

Click , then go to step 4.

Error – The run is unsuccessful. The software 
stopped the extraction because one or more raw 
spectra exceed 4000 FSU.
Click , then troubleshoot the failed run 
as explained in “Troubleshooting Background 
Calibrations” on page 15.

4. Click  (or select File Save) to save the 
background plate document.

5. Select File Close to close the background plate 
document.

Click here
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Troubleshooting Background Calibrations

Troubleshooting
Table

Isolating
Sample Block

Contamination

Signals exceeding 4000 FSU are considered outside the limit of normal background 
fluorescence and indicates that the either the background plate or the sample block may 
be contaminated.

1. Open the plate document for the background calibration.

2. In the toolbar, click  (Hide/Show System Raw Data Pane).

3. Select all wells in the plate document.

The SDS software highlights the selected wells and displays the raw spectral data.

4. Inspect the raw background data for an aberrant spectral peak or peaks.

Wells producing raw spectra that exceed 4000 FSU are considered irregular and 
could be contaminated. The following figure illustrates the raw data produced by a 
run on a sample block module containing a contaminated well.

5. Drag the vertical bar in the temperature plot to inspect all the data points. The 
location(s) of the contaminated well(s) is displayed in tooltip when you move the 
mouse over the curves in the graph.

Table 1-1 Troubleshooting background calibrations

Observation Possible Cause Recommended Action

Software will not extract 
background data

During setup, the wrong 
plate type was assigned to 
the plate document 

Run a new background 
plate document with the 
proper plate type setting.

Background is too high 
(>4000 FSU‡)

‡Fluorescent standard units – The measure of amplitude displayed along the Y-axis of the 
Background Plot.

See “Isolating Sample Block 
Contamination” below.

Background is too high 
(>4000 FSU)

Sample block 
contamination

1. Construct and run a new 
background plate.

2. See “Isolating 
Sample Block 
Contamination” below.

Background plate 
contamination

Possible contamination



Chapter 1 Performing Calibration and Verification Runs
Performing a Background Calibration

16 7900HT Fast System Maintenance and Troubleshooting Guide

Notes

6. Decontaminate the sample block as explained on page 65.

7. Run a background plate to confirm that the contaminants have been removed.

If the contamination is present after running the background plate for a second time, 
the background plate is likely to be the source of contamination.
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Performing a Pure Dye Calibration

Overview

When to Perform Applied Biosystems recommends performing a pure dye calibration:

• Every 6 months, depending on instrument use

IMPORTANT! The age and use of instrument components can affect pure spectra 
readings. Update the pure spectra data files once or twice annually, depending on 
the frequency of instrument use.

• Before performing an instrument verification run (see page 32)
• After installing a new, uncalibrated sample block (see page 53)

Purpose of the
Pure Dye

Calibrations

Before operating the instrument, you must generate spectral data by performing a pure 
dye calibration. During the pure dye calibration, the SDS software collects spectral data 
from a set of pure dye standards during a 2-minute hold at 60 °C. The SDS software 
stores the spectral data in the pure spectra run file, a calibration file located in the SDS 
directory. The SDS software uses the spectral data from the set of pure dye standards to 
distinguish the individual contribution of each dye in the collective fluorescence 
gathered by the instrument during a run.

After each run, the SDS software receives run data in the form of a raw spectra signal for 
each reading. To make sense of the raw data, the software must determine the 
contribution of each fluorescent dye used in the sample by comparing the raw spectra to 
the spectral data contained in the pure spectra run file.

Note: When a plate document is saved after analysis, the SDS software stores the pure 
spectra information with the collected fluorescent data for that experiment.

Dye Peak (nm)

1 FAM™ dye ~520

2 SYBR® Green dye ~520

3 TET™ dye ~540

4 VIC® dye ~550

JOE™ dye ~550

5 NED™ dye ~570

6 TAMRA™ dye ~580

7 ROX™ dye ~610

1 2 3 4 5 76
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Components of
the Pure Dye

Standards

The 7900HT Fast System is calibrated with several dyes, which are included in the 
calibration kits.

• The Sequence Detection Systems 384-Well Spectral Calibration Kit is provided for 
the standard 384-well sample block. This kit includes one 384-well pure dye plate, 
preloaded with the following dyes: FAM™ dye, JOE™ dye, NED™ dye, ROX™ dye, 
SYBR® Green dye, TAMRA™ dye, TET™ dye, and VIC® dye.

• The ABI PRISM® 7900HT Sequence Detection Systems 96-Well Spectral 
Calibration Kit is provided for the standard 96-well sample block. This kit includes 
two 96-well pure dye plates. Plate 1 is preloaded with the following dyes: 
FAM™ dye, JOE™ dye, NED™ dye, and ROX™ dye. Plate 2 is preloaded with the 
following dyes: SYBR® Green dye, TAMRA™ dye, TET™ dye, and VIC® dye.

• The 7900HT System Fast 96-Well Spectral Calibration Kit is provided for the Fast 
96-well sample block. This kit includes two 96-well pure dye plates. Plate 1 is 
preloaded with the following dyes: FAM™ dye, JOE™ dye, NED™ dye, and ROX™ 
dye. Plate 2 is preloaded with the following dyes: SYBR® Green dye, TAMRA™ 
dye, TET™ dye, and VIC® dye.

• The TaqMan® Low Density Array Spectral Calibration Kit is provided for the 
TaqMan® Low Density Array block. The kit includes three tubes of dye: FAM™ 
dye, ROX™ dye, and VIC® dye and three empty TLDAs. To perform a pure dye 
calibration, you load each dye into an empty TLDA.

Custom Pure
Dyes

The 7900HT Fast System supports the detection of custom pure dyes (dyes other than 
those provided by Applied Biosystems). To add custom pure dyes to the pure dye set for 
your instrument, see Appendix A on page 141.
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1

Before You Begin

Time Required 30 minutes

Materials
Required

You need the materials listed below to perform this procedure.

For 384- or 96-Well Sample Blocks

For the TaqMan Low Density Array Block

Powder-free gloves and safety goggles

Pure dye plate(s) from one of the following 
calibration kits:

• Sequence Detection Systems 384-Well 
Spectral Calibration Kit (PN 4323977)

• ABI PRISM® 7900HT Sequence Detection 
Systems 96-Well Spectral Calibration Kit 
(PN 4328639)

• 7900HT System Fast 96-Well Spectral 
Calibration Kit (PN 4351653)

Note: Both the standard 96-well and Fast 
96-well calibration kits contain two pure dye 
plates.

Centrifuge, with plate adapter

Powder-free gloves and safety goggles

TaqMan® Low Density Array Spectral 
Calibration Kit (PN 4362745). Use:

• The three dye tubes: FAM™ dye, 
ROX™ dye, and VIC® dye

• Three empty TLDAs

7900HT System Fast 96-Well
Spectral Calibration Kit

Caution!

May cause eye, skin, and respiratory

track irritation.

Made in USA

Part No: 4351653

Lot No: 0409003

Store at -15°C to -25°C

7900HT TaqMan®  Low

Density Empty Array

Part No:

Lot No:

For Research Use Only.

Not for use in

diagnostic procedures

0000001

1000002

Micro Fluidic Card

Spectral Calibration Reagents

Made in USA

Part No:

Lot No:

0000001

1000002
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Workflow To perform the pure dye calibration:

1. Perform a background calibration first (see page 3)

IMPORTANT! You must perform a background calibration before every pure dye 
calibration.

2. Obtain the tools and materials required (see pages 19 and 20).

3. Prepare the pure dye plate(s) (see page 21) or pure dye TLDAs (see page 23).

4. Create a plate document (see page 24).

5. Run the pure dye plate(s) or pure dye TLDAs (see page 27).

6. Analyze the pure dye data (see page 29).

Troubleshooting If you experience problems with the pure dye calibration, see “Troubleshooting Pure 
Dye Calibrations” on page 31.

Vortex

Micropipettors and pipet tips:

• Rainin F-100 micropipette (100-µL)

• Rainin Fine Point pipet tips (100-µL)

Centrifuge (For more information, see the 
TaqMan® Low Density Array Getting Started 
Guide.)

TaqMan® Low Density Array Sealer (For more 
information, see the TaqMan® Low Density 
Array Getting Started Guide.)

GR2170

G
R

21
72
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Preparing the Pure Dye Plate(s) 

IMPORTANT! You must perform a background 
calibration before every pure dye calibration.

1. Retrieve the calibration kit from the freezer, then 
remove the packaged pure dye plate(s).

Note: The standard 384-well calibration kit 
contains one pure dye plate. Both the standard 
96-well and Fast 96-well calibration kits contain 
two pure dye plates.

2. Return the calibration kit to the freezer.

3. Allow the pure dye plate(s) to warm to room 
temperature (approximately 5 min).

4. Remove a pure dye plate from its packaging.

IMPORTANT! Do not remove a pure dye plate 
from its packaging until you are ready to run it. 
The fluorescent dye contained in the wells of 
each pure dye plate is photosensitive. Prolonged 
exposure to light can diminish the fluorescent 
signal strength of the plate.

IMPORTANT! Do not discard the packaging for 
the pure dye plate. The pure dye plate can be 
used repeatedly if it is stored in its original 
packaging sleeve.

5. Briefly centrifuge the pure dye plate in a 
centrifuge with plate adapter. 

IMPORTANT! Wear powder-free 
gloves when you handle the pure 
dye plates.

>00:05:00Ambient

00:00:05<1500×g
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6. Verify that the pure dye standard in each well of 
the pure dye plate is positioned at the bottom of 
the well. If not, centrifuge the plate again at a 
higher rpm and for a longer period of time.

7. Proceed to “Creating a Pure Dye Plate 
Document” on page 24.

Correct Incorrect

Sample is 
positioned at 
bottom of well.

The plate has not been centrifuged 
with enough force, or has not been 
centrifuged for enough time.
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1

Preparing the Pure Dye TLDAs

IMPORTANT! You must perform a background 
calibration before every pure dye calibration.

Spectral Calibration Bulk 
FAM™, ROX™, and VIC® Dyes are combustible 
liquids and vapors. Exposure causes eye, skin, and 
respiratory tract irritation. Read the MSDS, and 
follow the handling instructions. Wear appropriate 
protective eyewear, clothing, and gloves.

1. Retrieve the calibration kit from the freezer and 
remove:

• The three dye tubes: FAM dye, ROX dye, 
and VIC dye

• Three empty TLDAs

2. Return the calibration kit to the freezer.

3. Allow the dyes to thaw at room temperature.

4. When the dyes have thawed, vortex the tubes.

5. Load the FAM dye into one of the empty 
TLDAs, loading 100 µL of dye per fill reservoir.

Note: For detailed loading procedures see the 
TaqMan® Low Density Array Getting Started 
Guide.

IMPORTANT! Wear powder-free 
gloves when performing this 
procedure.

Calibration 
reagents box

Dye tubes

Empty TLDAs

>00:05:00Ambient
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6. Repeat step 5 for the ROX and VIC dyes, using 
the two remaining empty TLDAs.

7. Centrifuge and seal the pure dye TLDAs.

Note: For centrifuging and sealing procedures 
see the TaqMan® Low Density Array Getting 
Started Guide.

8. Proceed to “Creating a Pure Dye Plate 
Document” on page 24.

Creating a Pure Dye Plate Document

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. If the login option is enabled, the Login dialog 
box appears. Enter your User Name and 
Password, then click OK.

Note: If the login option is not enabled, no 
Login dialog box appears. Skip to step 3 below.

3. Click  (or select File New).

4. Complete the New Document dialog box: 
a. Assay – Select Pure Spectra.
b. Container – Select the appropriate format.
c. Template – Select the appropriate template, 

as described in the table below.

4a

4b

4c

4d
4e

For Container... Select Template...

384 Wells Clear Plate 384 Well Pure Dyes Plate.sdt

96 Wells Clear Plate (for 
a Standard 96-Well 
Sample Block)

• 96 Well Pure Dyes Plate 1.sdt to 
run Plate 1 (containing FAM, JOE, 
NED, and ROX dyes)

• 96 Well Pure Dyes Plate 2.sdt to 
run Plate 2 (containing SYBR 
Green, TAMRA, TET, and VIC dyes)
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d. If the pure dye plate or pure dye TLDA is 
labeled with a barcode, click the Barcode 
field, then type in or scan the barcode 
number.

e. Click . The software creates and 
opens a plate document with the attributes 
for a pure dye calibration.

IMPORTANT! Do not modify the pure dye 
plate document.

5. Save the plate document:
a. Click  (or select File Save) to open the 

Save As dialog box.
b. If the Save in field does not display SDS 

Documents, navigate to Applied 
Biosystems SDS Documents.

c. In the File name field, type in an appropriate 
file name, as described in the table below.

96 Wells Clear Plate (for 
a Fast 96-Well Sample 
Block)

• Fast 96 Well Pure Dyes Plate 1.sdt 
to run Plate 1 (containing FAM, 
JOE, NED, and ROX dyes)

• Fast 96 Well Pure Dyes Plate 2.sdt 
to run Plate 2 (containing SYBR 
Green, TAMRA, TET, and VIC dyes)

384 Wells TaqMan Low 
Density Array

• TaqMan Low Density Array 
FAM Pure Dye.sdt to run the pure 
dye TLDA containing FAM dye

• TaqMan Low Density Array 
ROX Pure Dye.sdt to run the pure 
dye TLDA containing ROX dye

• TaqMan Low Density Array 
VIC Pure Dye.sdt to run the pure 
dye TLDA containing VIC dye

For Container... Select Template...

5b. This should be 
SDS Documents

5e
5c

5d

For Container... Type...

384 Wells Clear Plate PureDye_<date in MMDDYY format>

For example, the file name for a plate 
run on May 31, 2005, would be: 
PureDye_053105.

96 Wells Clear Plate (for 
a Standard 96-Well 
Sample Block)

PureDye_Plate<plate #>_<date in 
MMDDYY format>

For example, the file name for a Plate 1 
run on May 31, 2005, would be: 
PureDye_Plate1_053105.
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d. Select SDS 7900HT Document (*.sds) 
from the Files of type drop-down list.

e. Click . The software saves the plate 
document.

6. Continue with “Running a Pure Dye Plate or 
Pure Dye TLDA” on page 27.

96 Wells Clear Plate (for 
a Fast 96-Well Sample 
Block)

FastPureDye_Plate<plate #>_<date in 
MMDDYY format>

For example, the file name for a Fast 
Plate 1 run on May 31, 2005, would be: 
FastPureDye_Plate1_053105.

384 Wells TaqMan Low 
Density Array

<Dye><date in MMDDYY 
format>_TLDA

For example, the file name for a 
FAM dye TLDA run on May 31, 2005, 
would be: FAM_053105_TLDA.

For Container... Type...
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Running a Pure Dye Plate or Pure Dye TLDA

1. In the pure dye plate document, select the 
Instrument Real-Time tabs.

2. Click . The instrument tray rotates to 
the OUT position.

3. Place the pure dye plate or pure dye TLDA into 
the instrument tray as shown.

IMPORTANT! The pure dye plate or TLDA must 
be oriented so that the A1 position matches the 
A1 label on the instrument tray.

4. Click . The instrument tray rotates to 
the IN position and performs the pure dye 
calibration. 

Note: Before starting the run, the instrument 
may pause (up to 15 min) to bring the heated 
cover to the appropriate temperature.

5. When the pure dye calibration is complete and 
the Run Complete dialog box appears, 
click  to close the dialog box.

1

2

Well A1

Barcode

Standard 384-well reaction plate
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6. Click , then remove the pure dye 
plate or pure dye TLDA from the instrument 
tray.

 PHYSICAL INJURY 
HAZARD. During instrument operation, the 
sample block can be heated as high as 100 °C. 
Before removing the background plate or 
background TLDA, be sure to wait until the 
sample block reaches room temperature.

7. Place the pure dye plate or each pure dye TLDA 
inside its packaging, then return it to the 
calibration kit in the freezer.

IMPORTANT! Do not discard the pure dye plate 
or pure dye TLDAs. If you store it in its original 
packaging, you can use the pure dye plate or each 
pure dye TLDA for up to 6 months after you 
open it.

8. Continue with “Analyzing the Pure Dye Data” 
on page 29.

-20 to -25 °C
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Analyzing the Pure Dye Data

When you analyze the pure dye data, the SDS 
software extracts the calibration values from the pure 
dye plate document, then displays the spectral data in 
the Pure Dye Wizard.

The purpose of viewing the data in the Pure Dye 
Wizard is to eliminate irregular pure dye peaks from 
the data set. The wizard presents the spectral data in 
sets of three wells, each containing the same pure dye. 
Because the wells displayed by the wizard contain the 
pure dye at an identical concentration, the signal 
peaks for the set should be identical. Occasionally, 
pipetting inaccuracies or contamination can cause a 
well signal to shift slightly. While viewing the data, 
you must eliminate any outlying peaks.

To analyze the pure dye data:

1. In the pure dye plate document, select 
Analysis Extract Pure Dye Wizard.

2. Follow the instructions as explained in the Pure 
Dye Wizard to extract the pure dye spectra. 
When presented with each screen:

a. Inspect the spectra for shifts in peak 
location.

b. If the data set contains an outlying peak, 
eliminate it by clicking the check box of the 
associated well.

Note: Dye spectra are generally acceptable 
if they peak at the same location as their 
group but diverge slightly at other 
wavelengths.

c. Click  when finished.
d. Repeat steps a through c for all remaining 

wells until prompted with a message 
reporting the extraction of the pure dyes.

The software extracts the pure spectra and stores 
the data as a component of the calibration file.

3. Click  (or select File Save) to save the pure 
dye plate document.

2a. Peak shift

2b. Click here 
to remove it

2c
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4. Select File Close to close the pure dye plate 
document.

5. If you are performing the pure dye calibration 
for a:

• Standard 384-well sample block – The pure 
dye calibration is complete.

• Standard 96-well or Fast 96-well sample 
block – Run the second pure dye plate by 
repeating the following procedures:
– “Creating a Pure Dye Plate Document” 

on page 24
– “Running a Pure Dye Plate or Pure Dye 

TLDA” on page 27 
– “Analyzing the Pure Dye Data” on 

page 29
• TaqMan Low Density Array – Run the 

second and third pure dye TLDAs by 
repeating the following procedures for each 
TLDA:
– “Creating a Pure Dye Plate Document” 

on page 24
– “Running a Pure Dye Plate or Pure Dye 

TLDA” on page 27 
– “Analyzing the Pure Dye Data” on 

page 29

IMPORTANT! You must calibrate the instrument 
for all pure dye plates or pure dye TLDAs 
provided in your calibration kit.
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Troubleshooting Pure Dye Calibrations

Troubleshooting
Table

Table 1-2 Troubleshooting pure dye calibrations

Observation Possible Cause Recommended Action

Software will not extract 
pure dye data

During plate setup, the 
wrong plate type was 
assigned to the plate 
document 

Create and run a new pure 
dye plate document with the 
proper plate type setting

A background plate was not 
run before the pure dye 
plate or TLDA

Run a background plate, 
then run the pure dye plate 
or TLDA again

Raw data from pure dye 
calibration appears strange 
(see below)

Pure dye plate or TLDA was 
loaded backwards 

1. Verify the pure dye 
wavelengths are as 
expected.

2. Rerun the pure dye plate 
or TLDA.

Signals plateau (saturation) Intensity is set too high/low Call Applied Biosystems 
Technical Support.

Signal is too low 
(<10,000 FSU)

More than two outliers per 
dye in a single row

• Evaporation
• Contamination

Rerun the pure dye plate or 
TLDA. If the problem 
persists, discard the pure 
dye plate or TLDA and run a 
new one.
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Performing an Instrument Verification Run

Overview

When to Perform Applied Biosystems recommends performing an instrument verification run:

• Every 6 months
• As needed to verify the function of the 7900HT Fast System

Purpose of the
Verification Run

An instrument verification run is used to verify the performance of the 7900HT Fast 
System. During the run, TaqMan® RNase P reagents detect and quantify genomic copies 
of the human RNase P gene. (The RNase P gene is a single-copy gene encoding the 
RNA moiety of the RNase P enzyme.) 

For the 7900HT Fast System instrument verification runs, the TaqMan RNase P reagents 
are available in the following formats:

• TaqMan® RNase P Instrument Verification Plates (RNase P plates) – Verifies 
instrument performance for 7900HT instruments that use a Standard 384-Well 
Block, Standard 96-Well Block, or Fast 96-Well Block.

• TaqMan® Low Density Array RNase P Kit (TLDA RNase P kit) – Verifies 
instrument performance for 7900HT instruments that use a TaqMan® Low Density 
Array Block.

About RNase P
Plates

RNase P plates are pre-loaded with the reagents required to detect and quantify genomic 
copies of the human RNase P gene. Each well contains pre-loaded reaction mix 
(TaqMan® Universal PCR Master Mix, RNase P primers, and FAM™ dye-labeled probe) 
and a known concentration of human genomic DNA template.
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The table below illustrates the arrangement of standards and samples on each type of 
RNase P plate that is available for the 7900HT Fast System. The RNase P plates contain 
five replicate groups of standards (1250, 2500, 5000, 10,000, and 20,000 copies), two 
unknown populations (5000 and 10,000 copies), and template control (NTC) wells.

RNase P Plate Sample Configuration

TaqMan® RNase P 384-Well 
Instrument Verification 
Plate

TaqMan® RNase P 
Instrument Verification 
Plate

TaqMan® RNase P Fast 96-
Well Instrument Verification 
Plate

G
R

21
07

Unknown 1
5000

Unknown 2
10000

S
T

D
 1

25
0

S
T

D
 2

50
0

S
T

D
 5

00
0

S
T

D
 1

00
00

S
T

D
 2

00
00

N
T

C

G
R

21
08

Unknown 1
5000

NTC STD 1250 STD 2500

STD 5000 STD 10000 STD 20000

Unknown 2
10000
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About
the TLDA

RNase P Kit

The TLDA RNase P Kit includes one empty TLDA and eight tubes of solution. Each 
tube of solution contains reaction mix (TaqMan® Universal PCR Master Mix, RNase P 
primers, and FAM™-MGB dye-labeled probe) and a known concentration of human 
genomic DNA template.

To perform an instrument verification run, you load each solution into the empty TLDA. 
The figure below illustrates the arrangement of standards and samples. There are five 
replicate groups of standards (200, 400, 800, 1600, and 3200 copies), two unknown 
populations (800 and 1600 copies), and no template control (NTC).

1

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 PORT

1

2

3

4

5

6

7

8

NTC

Unknown A (800)

Unknown B (1600)

Standard 200

Standard 400

Standard 800

Standard 1600

Standard 3200
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Before You Begin

Time Required 2 hours

Materials
Required

You need the materials listed below to perform this procedure.

For 384- or 96-Well Sample Blocks 

For the TaqMan Low Density Array Block

Powder-free gloves and safety goggles

Appropriate RNase P plate for your sample 
block:

• TaqMan® RNase P 384-Well Instrument 
Verification Plate (PN 4323306)

• TaqMan® RNase P Instrument Verification 
Plate (PN 4310982, standard 96-well 
reaction plate)

• TaqMan® RNase P Fast 96-Well 
Instrument Verification Plate (PN 4351979)

Centrifuge, with plate adapter

Powder-free gloves and safety goggles

TaqMan® Low Density Array RNase P Kit 
(PN 4351468)

TaqMan®
RNase P 384-Well Instrument Verification Plate
Caution, May cause eye, skin, and

respiratory tract irritation. Read MSDS.
Part Number 4323306

Store at -15°C to -25°C

For Research Use Only

Not for use in diagnostic procedures

7900HT TaqMan®  Low

Density Empty Array

Part No:

Lot No:

For Research Use Only.

Not for use in

diagnostic procedures

0000001

1000002

Micro Fluidic Card

Spectral Calibration Reagents

Made in USA

Part No:

Lot No:

0000001

1000002
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Workflow To perform an instrument verification run:

1. Perform a pure dye calibration (see page 17) before performing the instrument 
verification run.

2. Obtain the tools and materials required (see pages 35 and 36).

3. Prepare the RNase P plate (see page 37) or RNase P TLDA (see page 39).

4. Create a plate document (see page 41).

5. Run the RNase P plate or RNase P TLDA (see page 43).

6. Analyze the run data (see page 44).

7. Verify instrument performance (see page 47).

Micropipettors and pipet tips:

• Rainin F-100 micropipette (100-µL)

• Rainin Fine Point pipet tips (100-µL)

Centrifuge (For more information, see the 
TaqMan® Low Density Array Getting Started 
Guide.)

TaqMan® Low Density Array Sealer (For more 
information, see the TaqMan® Low Density 
Array Getting Started Guide.)

GR2170
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Preparing the RNase P Plate

1. Retrieve the RNase P package from the freezer, 
then remove the packaged RNase P plate.

Note: For the standard 96-well RNase P plate, 
also use the compression pad provided in the 
package. Compression pads are not provided and 
should not be used for the Fast 96-well or 
standard 384-well RNase P plates.

2. Allow the RNase P plate to warm to room 
temperature (approximately 5 min).

3. Remove the RNase P plate from its packaging.

4. Briefly centrifuge the RNase P plate in a 
centrifuge with plate adapter. 

IMPORTANT! Wear powder-free 
gloves when you handle the RNase 
plate.

>00:05:00Ambient

00:00:05<1500×g
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5. Verify that the liquid in each well of the RNase P 
plate is positioned at the bottom of the well. If 
not, centrifuge the plate again at a higher rpm 
and for a longer period of time.

6. Proceed to “Creating a Plate Document for the 
Verification Run” on page 41.

IMPORTANT! To prevent degradation of the 
reaction components, start the run as soon as 
possible.

Correct Incorrect

Sample is 
positioned at 
bottom of well.

The plate has not been centrifuged 
with enough force, or has not been 
centrifuged for enough time.
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Preparing the RNase P TLDA

1. Remove the TLDA RNase P kit from the freezer, 
then unpack the contents:

• Eight tubes of solution
• One empty TLDA

2. Remove the empty TLDA from its packaging.

3. Allow the eight tubes of solution to thaw at room 
temperature (approximately 5 min).

4. Mix the contents of each tube by tapping gently.

5. Using the empty TLDA, load 100 µL of the first 
solution into the designated reservoir.

Note: The insert in the TLDA RNase P kit 
describes the designated reservoirs.

Note: For detailed loading procedures see the 
TaqMan® Low Density Array Getting Started 
Guide.

6. Repeat step 5 for the remaining solutions.

IMPORTANT! Wear powder-free 
gloves when performing this 
procedure.

Verification 
reagents box

Empty 
TLDA

>00:05:00Ambient
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7. Centrifuge and seal the three RNase P TLDAs.

Note: For centrifuging and sealing procedures 
see the TaqMan® Low Density Array Getting 
Started Guide.

8. Proceed to “Creating a Plate Document for the 
Verification Run” on page 41.

IMPORTANT! To prevent degradation of the 
reaction components, start the run as soon as 
possible.
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Creating a Plate Document for the Verification Run

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. If the login option is enabled, the Login dialog 
box appears. Enter your User Name and 
Password, then click OK.

Note: If the login option is not enabled, no 
Login dialog box appears. Skip to step 3 below.

3. Click  (or select File New).

4. Complete the New Document dialog box: 
a. Assay – Select Standard Curve (AQ).
b. Container – Select the appropriate format.
c. Template – Select the appropriate template, 

as described in the table below.

d. If the RNase P plate or RNase P TLDA is 
labeled with a barcode, click the Barcode 
field, then type in or scan the barcode 
number.

e. Click . The software creates and 
opens a plate document.

IMPORTANT! Do not modify the plate 
document. The plate document template is 
programmed with the appropriate detector 
and method information for the instrument 
verification run.

4a

4b

4c

4d
4e

For Container... Select Template...

384 Wells Clear Plate 384 Well RNaseP Install Plate.sdt

96 Wells Clear Plate (for 
a Standard 96-Well 
Sample Block)

96 Well RNaseP Install Plate.sdt

96 Wells Clear Plate (for 
a Fast 96-Well Sample 
Block)

Fast 96 Well RNaseP Install.sdt

384 Wells TaqMan Low 
Density Array

TaqMan Low Density Array 
RNaseP.sdt
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5. Save the plate document:
a. Click  (or select File Save) to open the 

Save As dialog box.
b. If the Save in field does not display SDS 

Documents, navigate to Applied 
Biosystems SDS Documents.

c. In the File name field, type in an appropriate 
file name, as described in the table below.

d. Select SDS 7900HT Document (*.sds) 
from the Files of type drop-down list.

e. Click . The software saves the plate 
document.

6. Continue with “Running the RNase P Plate or 
RNase P TLDA” on page 43.

5b. This should be 
SDS Documents

5e
5c

5d

For Container... Type...

384 Wells Clear Plate Verification_<date in MMDDYY 
format>

For example, the file name for a plate 
run on May 31, 2005, would be: 
Verification_053105.

96 Wells Clear Plate (for 
a Standard 96-Well 
Sample Block)

Verification_<date in MMDDYY 
format>

For example, the file name for a plate 
run on May 31, 2005, would be: 
Verification_053105.

96 Wells Clear Plate (for 
a Fast 96-Well Sample 
Block)

FastVerification_<date in MMDDYY 
format>

For example, the file name for a Fast 
plate run on May 31, 2005, would be: 
FastVerifiation_053105.

384 Wells TaqMan Low 
Density Array

Verification<date in MMDDYY 
format>_TLDA

For example, the file name for an 
RNase P TLDA run on May 31, 2005, 
would be: Verification_053105_TLDA.
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Running the RNase P Plate or RNase P TLDA

1. In the plate document, select the 
Instrument Real-Time tabs.

2. Click . The instrument tray rotates to 
the OUT position.

3. Place the RNase P plate or RNase P TLDA into 
the instrument tray as shown.

IMPORTANT! The RNase P plate or TLDA must 
be oriented so that the A1 position matches the 
A1 label on the instrument tray.

4. Click . The instrument tray rotates to 
the IN position and performs the instrument 
verification run. 

Note: Before starting the run, the instrument 
may pause (up to 15 min) to bring the heated 
cover to the appropriate temperature.

5. When the instrument verification run is complete 
and the Run Complete dialog box appears, 
click  to close the dialog box.

1

2

Well A1

Barcode

Standard 384-well reaction plate
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6. Click , then remove the RNase P 
plate or RNase P TLDA from the instrument 
tray.

 PHYSICAL INJURY 
HAZARD. During instrument operation, the 
sample block can be heated as high as 100 °C. 
Before removing the RNase P plate or RNase P 
TLDA, be sure to wait until the sample block 
reaches room temperature.

7. Proceed to “Analyzing the Instrument 
Verification Run” below.

Analyzing the Instrument Verification Run

1. Click  (or select Analysis > Analyze). The 
SDS software analyzes the run data. A status bar 
at the bottom of the plate document window 
indicates progress; the status bar disappears 
when the analysis is complete.

2. View the results:

a. In the Plate Grid, click the box above the A 
label to select all wells.

b. Click the Results tab to view the plots.

3. Choose from the following: 
• Automatic Ct – The SDS software 

automatically generates baseline values for 
each well and threshold values for each 
detector.

Click here
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• Manual Ct – The SDS software calculates baseline and threshold values for a 
detector based on the assumption that the data exhibits typical amplification 
curves. If you are setting the baseline manually, specify the Start and End 
cycles.

IMPORTANT! After analysis, you must verify that the baseline and threshold were 
called correctly for each well by clicking on the well in the Plate Grid and viewing 
the resulting plots. For more information about manually adjusting the baseline and 
threshold settings, refer to the Sequence Detection Systems Software version 2.3 
Online Help (SDS Online Help).

4. If necessary, remove outliers:
a. Determine the outlier well positions.

Note: The CT vs. Well Position view in the Results tab can help you determine 
the outlier well positions. To access this view, click the Plot drop-down list at 
the bottom of the Amplification Plot.

4a
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b. In the Plate Grid, select the outlier wells. 

Note: To select more than one well at a time, hold down the ctrl key while 
selecting the wells.

The number of wells that can be removed to pass specifications is shown in the 
table below.

c. Click the Setup tab, then select the Omit Wells(s) check box. A red ✕ appears 
in each of the selected wells in the Plate Grid.

5. Click  (or select Analysis > Analyze) to reanalyze the data. 

6. Proceed to “Verifying Instrument Performance” on page 47.

Format

Maximum No. of Wells that Can be 
Removed from Each Set

Unknowns Standards

Standard 96-well 
RNase P Plate

6 1

Fast 96-well RNase 
P Plate

6 1

Standard 384-well 
RNase P Plate

10 2

RNase P TLDA 4 4
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Verifying Instrument Performance

Specification
Calculation

During analysis, the SDS software generates a standard curve from the averaged 
threshold cycle (CT) values of the replicate groups of standards, then calculates the 
concentration of the two unknown populations using the standard curve. To complete the 
verification, the average copy number (mean quantity) and standard deviation for the 
unknown populations are entered into the following formula to assess the instrument 
performance:

(Qty Unk (high copy)) − 3 (Qty σ (high copy)) > (Qty Unk (low copy)) + 3 (Qty σ (low copy)) 

where:

The calculation states that the average copy number of the larger (10,000 for reaction 
plates or 1600 for TLDAs) unknown population minus three standard deviations is 
greater than the average copy number of the smaller (5000 for reaction plates or 800 for 
TLDAs) unknown population plus three standard deviations. If the calculation is true, 
then the instrument passes the validation specification, verifying instrument 
performance.

Calculation 
Term Value

Unknown Populations

Standard 96-
well RNase P 

Plate

Fast 96-well 
RNase P Plate

Standard 384-
well RNase P 

Plate
RNase P TLDA

Qty Unk (high copy) Average quantity of high copy 
number

10,000 10,000 10,000 1600

Qty σ (high copy) Quantity standard deviation of 
high copy number

Qty Unk (low copy) Average quantity of low copy 
number

5000 5000 5000 800

Qty σ (high copy) Quantity standard deviation of 
low copy number
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Calculating the
Results

1. In the Results Table of the plate document window, locate and record the average 
copy number (Qty mean) and standard deviation (Qty std dev) for the two 
unknown populations.

2. Insert the values into the specification calculation:
(Qty Unk (high copy)) − 3 (Qty σ (high copy)) > (Qty Unk (low copy)) + 3 (Qty σ (low copy))

3. Determine whether the specification calculation is true or false.
• If the calculation is true, the 7900HT Fast System passes the validation 

specification. Instrument performance is verified.
• If the calculation is false, the 7900HT Fast System fails the validation 

specification. The instrument performance cannot be verified.

1
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Recommended
Maintenance Schedule

Decontaminating the
Sample Block

Removing and
Installing a Sample Block

Replacing the
Plate Adapter

Performing
Calibration and
Verification Runs

Maintaining the
Computer and
Software

Maintaining the
Automation
Accessory

Flags and Filtering

Troubleshooting
Chemistry and
Assay Runs

See page 62

See page 65

See page 52

See page 53



Chapter 2 Maintaining the 7900HT Instrument Hardware
Recommended Maintenance Schedule

52 7900HT Fast System Maintenance and Troubleshooting Guide

Notes

Recommended Maintenance Schedule
To ensure optimal performance of your 7900HT Fast System, perform the following 
tasks as indicated in the table below.

Schedule Maintenance Task

Weekly • Cycle the computer and instrument power (power off, then 
power on the computer and instrument)

• Wipe instrument surfaces with a lint-free cloth

IMPORTANT! Never use organic solvents to clean the 7900HT 
Fast System.

As needed • Remove and install a sample block (see page 53)

• Replace the plate adapter (see page 62)

• Decontaminate the sample block (see page 65)

Su M T W Th F S

Week (7 Days)
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Removing and Installing a Sample Block

When to Perform You need to remove/install a sample block when you:

• Decontaminate the wells of the sample block (see page 65)
• Change sample blocks

Before You Begin

Time Required 15 minutes. The time will be longer if you have to perform background or pure dye 
calibrations, or if you have an Automation Accessory.

Materials
Required

You need the materials listed below to perform this procedure.

Workflow To remove/install the sample block:

1. Be sure all required upgrades to the SDS software and 7900HT instrument firmware 
are installed (see page 83).

IMPORTANT! Failure to upgrade the software and firmware can make the 
instrument inoperable or result in damage to instrument components.

2. Obtain the tools and materials required (shown above).

3. Review the sample block handling information (see page 55).

5/32 inch hex key 

Note: Some instruments require the 5/32-
inch hex key to remove the sample block 
locking bar. Other instruments have only a 
thumbscrew securing the sample block 
locking bar to the instrument chassis.

5/16 inch hex key 

Note: Some instruments may require a 
crescent wrench rather than the 5/16-inch 
hex key.

If you are replacing the sample block, one of 
the following:

• 7900HT System Standard 384-Well Block

• 7900HT System Standard 96-Well Block

• 7900HT System Fast 96-Well Block

• 7900HT System TaqMan® Low Density 
Array Block

Warning

G
R

20
28
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4. Remove the sample block (see page 56).

5. Reinstall the same sample block or install a new sample block (see page 58).

6. After the sample block is successfully installed, perform a background calibration 
(see page 3) to verify that the sample block:

• Is connected and working properly 
• Contains no contaminants that will interfere with fluorescent detection

IMPORTANT! Perform a background calibration after installing the sample block, 
even if you are reinstalling the same sample block or replacing it with another block 
of the same format.

If you installed a new, uncalibrated sample block, also do the following:

7. Change the plate adapter (see page 62).

8. Perform a pure dye calibration to create the pure dye calibration values for the new 
sample block (see page 17).

9. Perform a verification run to confirm the proper operation of the new sample block 
(see page 32).

If you are using an Automation Accessory, also do the following:

10. If you changed sample block formats (for example, replacing a Standard 384-Well 
Block with a Fast 96-Well Block), adjust the plate sensor switch on the Zymark® 
Twister Microplate Handler arm for the new plate format (see page 92).

11. Align the Plate Handler for the new plate format (see page 97).

12. Align the fixed-position bar code reader for the new plate format (see page 110).
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Handling the
Sample Block

The interchangeable sample blocks are delicate pieces of equipment containing several 
fragile components that can break if handled improperly. The figure below shows the 
correct locations for handling the interchangeable sample blocks. 

G
R

20
28

Heat sinks 

Circuitry and connections to 
the instrument (Do Not Touch)

Hold sample block 
module from the sides(Bottom of module)
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Removing the Sample Block

1. Confirm the function of the current module:

Note: If you do not have the SDS Automation 
Controller software, skip to step 2 below.

a. Double-click  on the desktop (or select 
Start > All Programs > Applied 
Biosystems > SDS 2.3 > SDS Automation 
Controller 2.3) to start the Automation 
Controller Software.

b. Select the Run Status tab. The module is 
operating normally if the software is 
receiving a temperature reading.

c. Click Open/Close Door to rotate the 
instrument tray to the OUT position.

d. Select File > Exit to close the Automation 
Controller Software.

2. Power off and unplug the 7900HT instrument.

PHYSICAL HAZARD. 
The instrument must be unplugged and powered 
off at all times during the following procedure. 
Failure to comply can result in serious physical 
injury to the user or damage to the instrument.

3. Wait 20 to 30 min for the heated cover to cool.

PHYSICAL HAZARD. 
During instrument operation, the temperature of 
the sample block can be as high as 100 °C. 
Before performing this procedure, wait until the 
sample block reaches room temperature.

4. If the instrument tray is in the OUT position 
(outside of the instrument), push it into the 
instrument to provide an open workspace.

G
R
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5. If using a Plate Handler, remove the covers for 
the fixed-position bar code reader and the 
underlying platform.

6. Push the instrument tray inside the instrument, 
then remove the thermal cycler access cover to 
permit access to the sample block.

IMPORTANT! The thermal cycler access cover is 
secured to the instrument by non-locking pins 
and may require force to remove it (no tools are 
required).

7. Using a 5/16-inch hex key, turn the sample block 
locking bolt counter-clockwise until it is very 
loose but still attached to the sample block 
locking bar. 

IMPORTANT! Some instruments may require the 
use of an adjustable crescent wrench to loosen 
the sample block locking bolt.

8. Loosen the thumbscrew securing the sample 
block locking bar to the instrument chassis (may 
be a 5/32-inch hex bolt on some instruments).

GR2009
7900HT
Front view with Robot

7900HT FAST Real-Time PCR System

GR2009

Fixed-position bar code reader 
and underlying platform covers
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Sample block 
locking bar
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9. Lift the sample block locking bar up and out of 
the instrument.

10. Remove the sample block from the instrument:

a. Rotate the release lever at the base of the 
sample block 90 degrees.

b. Being careful not to damage the heat sinks 
on the bottom of the sample block, slide the 
sample block out of the instrument and 
place it on a clean, level surface.

Installing a Sample Block

IMPORTANT! Before installing the sample block, 
perform all required upgrades to the SDS software 
and instrument firmware. Failure to upgrade the 
software and firmware can render the instrument 
inoperable or result in damage to instrument 
components.

1. Load the sample block into the instrument 
compartment:

a. Being careful not to damage the heat sinks 
on the bottom of the sample block, rest the 
sample block on the metal runners on either 
side of the instrument bay.

G
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b. Carefully slide the sample block into the 
instrument until the front of the block is 
flush with the rear of the locking bar.

c. After it is seated, firmly press on the sample 
block to ensure a good connection.

2. Replace the sample block locking bar.

3. Tighten the thumbscrew (from step 8 on page 57) 
to secure the sample block locking bar to the 
instrument chassis (may be a 5/32-inch hex bolt).

4. Using the 5/16-inch hex key, turn the sample 
block locking bolt clockwise until it is flush with 
the locking bar.

5. Again, press on the right and left sides of the 
front surface of the sample block to ensure that it 
is seated securely.

6. Replace the thermal cycler access cover:
a. Fit the lip at the bottom of the access cover 

over the lower edge of the bay.

b. Push the cover towards the instrument until 
it snaps into place.

IMPORTANT! You must reinstall the thermal 
cycler access cover before powering on the 
instrument. Failure to do so prevents power from 
being applied to the thermal cycler electronics, 
heated clamp motor, and laser safety interlocks.
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7. If using a Plate Handler, replace the covers for 
the fixed-position bar code reader and the 
underlying platform (removed in step 5 on 
page 57).

8. Plug in and power on the 7900HT instrument.

9. Confirm the function of the installed sample 
block:

Note: If you do not have the SDS Automation 
Controller software, skip this step.

a. Double-click  on the desktop (or select 
Start > All Programs > Applied 
Biosystems > SDS 2.3 > SDS Automation 
Controller 2.3) to start the Automation 
Controller Software.

Fixed-position bar code reader 
and underlying platform covers
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b. Select the Run Status tab. The sample block is operating normally if the 
software is receiving a temperature reading. 

Does the software 
display temperatures? Then…

Yes the installation is successful.

The presence of temperature readings confirm that the 
7900HT instrument successfully established the 
connection to the new sample block. 

No the 7900HT instrument is unable to establish 
communication with the new sample block.

To troubleshoot the problem:

1. Power off and unplug the 7900HT instrument.

2. Remove the thermal cycler access cover.

3. Press on the right and left sides of the front plate of 
the sample block to ensure that it is seated 
securely.

4. Reinstall the thermal cycler access cover.

5. Repeat step 8 and step 9 on page 60 until you hear 
a high-pitched tone confirming communication 
between the instrument and sample block.
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Replacing the Plate Adapter

When to Perform Replace the 7900HT instrument plate adapter after:

• Changing the sample block format (for example, replacing a Standard 384-Well 
Block with a Fast 96-Well Block)

Note: The sample block must be used with a corresponding plate adapter (that is, both 
the sample block and the plate adapter must have the same plate format).

Before You Begin

Time Required 5 to 10 minutes

Materials
Required

You need the materials listed below to perform this procedure.

Workflow To replace the plate adapter:

1. Obtain the tools and materials required (shown above).

2. Replace the plate adapter (see page 63).

Flat-blade screwdriver

One of the following:

• 384-Well Plate Adapter

• 96-Well Plate Adapter

• Fast 96-Well Plate Adapter

• TaqMan® Low Density Array Adapter
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Replacing the Plate Adapter

1. If the instrument tray is inside the 7900HT 
instrument, move the instrument tray to the OUT 
position:

a. Double-click  on the desktop (or select 
Start > All Programs > Applied 
Biosystems > SDS 2.3 > SDS 2.3) to start 
the SDS software.

b. Click  (or select File > New).
c. In the New Document dialog box, 

click .
d. In the new plate document, select the 

Instrument > Real-Time tabs.
e. Click .
f. The instrument tray rotates to the OUT 

position.
g. Select File > Exit to close SDS software.

2. Remove the four screws attaching the plate 
holder to the plate arm.

3. Remove the plate adapter from the instrument 
tray.

Note: If changing sample block formats (for 
example, replacing a Standard 384-Well Block 
with a Fast 96-Well Block), store the plate 
adapter with the sample block of the same 
format.

G
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4. Place the new plate adapter into the instrument 
tray with the A1 label in the rear-left corner. 

IMPORTANT! Make sure to install the correct 
version of the plate adapter for the plate format 
you intend to use. The plate adapters are labeled 
with the format they support.

5. Replace and tighten the four screws in the order 
shown.

IMPORTANT! The order in which the screws are 
tightened is important to ensure proper alignment 
of the plate to the sample block inside the 
7900HT instrument.

G
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Well A1 

Label

1

2

3

4
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Decontaminating the Sample Block

Overview

This section describes how to decontaminate the wells of a sample block. The procedure 
eliminates residual PCR-related products, including fluorescent labeled TaqMan® 
probes.

Using Other
Methods

IMPORTANT! If you plan to use a decontamination method other than the one in this 
guide, check with Applied Biosystems first to ensure that the method will not damage 
the sample block or the 7900HT instrument. 

When to Perform Decontaminate the sample block as often as needed. 

Note: Decontamination is generally performed to resolve problematic background 
calibrations, where one or more wells consistently exhibit abnormally high signals 
indicating the presence of a fluorescent contaminant.

Before You Begin

Time Required 30 minutes. The time may vary, depending on the extent of the contamination.

Materials
Required

You need the materials listed below to perform this procedure.

Powder-free gloves and safety goggles

Pipettors and pipet tips (100-µL)

10% Sodium hypochlorite (bleach) solution

Water, deionized

Isopropanol, 100 percent pure

Cotton swabs and lint-free cloths
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Workflow To decontaminate the sample block:

1. Remove the sample block from the 7900HT instrument (see page 53).

2. Obtain the tools and materials required for decontamination (shown above).

3. Decontaminate the sample block:
• For a Standard 384-Well Block, Standard 96-Well Block, or Fast 96-Well 

Block, see page 67
• For a TaqMan® Low Density Array Block, see page 70

4. Replace the sample block (see page 58).

5. Perform a background calibration to confirm that the contamination has been 
removed (see page 3).
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Decontaminating a Sample Block

This procedure applies to a:

• Standard 384-Well Block
• Standard 96-Well Block
• Fast 96-Well Block

1. Suspected contaminated wells are those that give 
a signal >4000 FSU during a background 
calibration (see page 14). Using the SDS 
software, isolate the suspected contaminated 
wells as explained on page 15.

2. Locate the suspected contaminated wells on the 
sample block, using the figure at right as a guide.

Warning

G
R

20
28

Well A-1

Circuitry and 
connections to 
the instrument 
(Do Not Touch)
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3. Rinse (pipet and remove) each contaminated 
well with three treatments of deionized water at 
the appropriate volume for the sample block:

• 40 µL per well for a Standard 384-Well 
Block

• 150 µL per well for a Standard 96-Well 
Block

• 55 µL per well for a Fast 96-Well Block

Note: Absolute isopropanol can be substituted 
for water in the third treatment.

CHEMICAL HAZARD. 
Isopropanol is a flammable liquid and vapor. It 
may cause eye, skin, and upper respiratory tract 
irritation. Prolonged or repeated contact may dry 
skin and cause irritation. It may cause central 
nervous system effects such as drowsiness, 
dizziness, and headache, etc. Please read the 
MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

4. Using a cotton swab, scrub inside of each 
contaminated well.

Note: If you are decontaminating a Standard 
384-Well Block, remove some of the cotton from 
the swab tip; this allows the swab to reach the 
bottom of the wells.

5. Using a lint-free cloth, absorb the excess 
deionized water or isopropanol from the wells.
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6. Pipet the appropriate volume of 10% bleach 
solution into each suspected contaminated well:

• 40 µL per well for a Standard 384-Well 
Block

• 150 µL per well for a Standard 96-Well 
Block

• 55 µL per well for a Fast 96-Well Block

CHEMICAL HAZARD. 
Sodium hypochlorite (bleach) is a liquid 
disinfectant that can be corrosive to the skin and 
can cause skin depigmentation. Please read the 
MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

7. Allow the sample block to sit for 3 to 5 min.

8. Using a pipet, remove the bleach solution from 
the wells.

9. Rinse (pipet and remove) the wells with 
deionized water at the appropriate volume for the 
sample block:

• 40 µL per well for a Standard 384-Well 
Block

• 150 µL per well for a Standard 96-Well 
Block

• 55 µL per well for a Fast 96-Well Block

10. Using a lint-free cloth, absorb the excess 
deionized water from the wells.
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Decontaminating a TLDA Block 

This procedure applies to the TaqMan Low Density 
Array Block.

1. Using a lint-free cloth, wipe the surface of the 
sample block (grey aluminum) with 10% bleach.

CHEMICAL HAZARD. 
Sodium hypochlorite (bleach) is a liquid 
disinfectant that can be corrosive to the skin and 
can cause skin depigmentation. Please read the 
MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

2. Wipe the sample block three times with distilled 
water.

3. Wipe the sample block with isopropanol.

CHEMICAL HAZARD. 
Isopropanol is a flammable liquid and vapor. It 
may cause eye, skin, and upper respiratory tract 
irritation. Prolonged or repeated contact may dry 
skin and cause irritation. It may cause central 
nervous system effects such as drowsiness, 
dizziness, and headache, etc. Please read the 
MSDS, and follow the handling instructions. 
Wear appropriate protective eyewear, clothing, 
and gloves.

4. Allow the sample block to air dry.
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Recommended Maintenance Schedule
To ensure optimal performance of your 7900HT Fast System, perform the following 
tasks as indicated in the table below.

Schedule Maintenance Task

Weekly Archive or backup SDS plate document files (see page 73)

Monthly Defragment the computer hard drive (see page 76)

As needed • Manage local user accounts in the SDS software (see page 78)

• Update the SDS software (see page 83)

• Update the operating system software (see page 83)

Su M T W Th F S

Week (7 Days)

Su M T W Th F S

Month (30 Days)
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Archiving and Backing Up SDS Software Files

When to Perform Weekly

Archiving SDS
Software Files

To conserve space on the computer hard drive, SDS software files can be archived using 
a data compression utility. A compression utility typically archives files by encoding the 
binary data they contain algorithmically, thereby reducing the size of a file. 

Several commercially available compression utilities are available. PKZIP and *.arc are 
archive formats common to the Microsoft Windows® operating system.

Backing Up SDS
Software Files

Applied Biosystems strongly recommends that you back up the data generated by your 
7900HT Fast System for two reasons: 

• Backing up data protects against potential loss of data caused by an unforeseen 
failure of the computer or its hard drive(s).

• Backing up older data and removing it from the computer hard drive conserves 
space on the hard drive and optimizes performance.

Choosing a Backup Storage Device 

Applied Biosystems recommends the use of one or more backup storage devices to 
prevent potential loss of data caused by unforeseen failures of the computer or its hard 
drive(s). 

The CD-RW drive of the computer can serve as the backup storage device for your 
system. By saving your *.sds and *.sdt files to one or more writable CDs on a weekly 
basis, you can effectively backup the data generated by your 7900HT Fast System.

Developing a
Data

Management
Strategy

Applied Biosystems recommends developing a strategy for dealing with the files 
produced by the SDS software. During a single day of real-time operation, the 
7900HT System can generate over 200 MB of data. Without a strategy for distributing 
and archiving SDS software files, the 7900HT instrument can easily fill the hard drive of 
the computer within just a few weeks of operation.

If you are performing real-time experiments on your 7900HT Fast System, check the 
amount of available space on your hard drive weekly. When the hard drive is within 20% 
of it’s capacity, transfer the older data to a backup storage device. 

Note: Real-time experiments include standard curve (AQ) assays and comparative CT 
(RQ) assays, as well as any amplification (AQ) runs you might perform on the 
7900HT System for allelic discrimination assays or plus/minus assays.

To successfully manage the information produced by the 7900HT System, you should 
have a basic understanding of how data is collected, stored, and processed throughout 
the operation of the instrument. See “Modes of Operation” on page 74.
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Modes of Operation

System Operation
and Dataflow

Data management strategy is a crucial element of successfully integrating the Applied 
Biosystems 7900HT Fast Real-Time PCR System into a laboratory workflow. During a 
single 24-hour period of real-time operation, the 7900HT instrument can produce more 
than 200 MB of data. To successfully manage the information produced by the 
7900HT System, you should have a basic understanding of how data is collected, stored, 
and processed throughout the operation of the instrument.

Standard Modes
of Operation

The 7900HT Fast System has two standard modes of operation, depending on the 
accessories purchased with the base instrument:

• Stand-Alone Operation (see below)
• Automated Operation (see page 75)

Stand-Alone Operation

In this mode (the most basic configuration of the 7900HT Fast System), the 7900HT 
instrument is used without any additional components. In this configuration (see the 
figure below), a technician runs plates individually using the SDS software. The 
computer stores all data for instrument operation and provides the software for analyzing 
the run data.

Hard drive(s)

 Computer 

Serial 
Cable

Plate Document 
Created

*.sds 
file

 SDS Software 

Thermal Cycling and 
Sequence Detection

Instrument Firmware 

*.sdt 
file

Data Collection

Plate Document Used 
to Run a Plate

Plate Document 
Opened and Analyzed

GR2179
7900HT raven
instrument front

7900HT FAST Real-Time PCR System 1

2

3

4

5

6

Raw Data Saved to 
the Plate Document

Applied Biosystems 7900HT 
Fast Real-Time PCR System
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Automated Operation

In this mode, the 7900HT Fast System uses an Automation Accessory (Zymark® Twister 
Microplate Handler and fixed-position bar code reader) to provide high-throughput 
operation suitable for small- to medium-scale studies. With this configuration (see the 
figure below), a technician can use the Automation Controller Software to run batches of 
plates unattended. As in Stand-Alone mode, the computer stores all data for instrument 
operation and provides the software for analyzing the run data.

Hard drive(s)

 Computer 

Serial 
Cable

Automation Controller 
Software

Thermal Cycling and 
Sequence Detection

Instrument Firmware 

GR2009
7900HT
Front view with Robot

7900HT FAST Real-Time PCR System

GR2009

Data Collection

2

3

4

5
Raw Data Saved to 

the Plate Documents

Plate document files 
added to and run from 

the plate queue

Plate Documents 
Created

1

 SDS Software 

Plate Document 
Opened and Analyzed

6

*.sds 
files *.sdt 

file

Applied Biosystems 7900HT 
Fast Real-Time PCR System



Chapter 3 Maintaining the Computer and Software
Defragmenting the Hard Drive

76 7900HT Fast System Maintenance and Troubleshooting Guide

Notes

Defragmenting the Hard Drive

When to Perform • At least once every month
• Before fragmentation reaches 10% (or when warned by the Windows operating 

system)

Purpose: Why
Defragment the

Hard Drive?

As the 7900HT Fast System is used and files are deleted and created, the free space on 
the computer hard drive eventually is split into increasingly smaller blocks. 
Consequently, as the SDS software creates new files and extends old ones, the computer 
cannot store each file in a single block. Instead, the system will ‘fragment’ the files by 
scattering their component pieces across different sectors of the hard drive. 

The fragmentation of SDS files decreases the performance of both the SDS software and 
the computer operating system. As the hard drive becomes fragmented, programs take 
greater time to access files because they must perform multiple seek operations to access 
the fragments. Defragmentation utilities defragment broken files by combining their 
component pieces at a single location on the hard drive, thereby optimizing system 
performance. 
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Defragmenting the Hard Drive

1. In the Windows desktop, select  
My Computer.

2. In the My Computer window, right-click a hard 
drive and select Properties.

3. In the Local Disk Properties dialog box:
a. Select the Tools tab.
b. Click  to open the Disk 

Defragmenter dialog box.

4. Click .

5. When the Defragmentation Complete dialog box 
displays, click .

6. In the Local Disk Properties dialog box, 
click .

7. Repeat steps 2 through 6 for the remaining drives 
on the computer.

2 

3a

3b

4 
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Managing Local User Accounts in the SDS Software
Managing local user accounts includes the following:

• Enabling or disabling the SDS software login function (page 79)
• Adding user accounts (page 79)
• Editing user accounts (page 81)
• Deleting user accounts (page 82)

Non-Enterprise
Mode Only

This section applies to the SDS software in non-Enterprise mode (that is, the SDS 
software does not include the SDS Enterprise Database). For versions of the SDS 
software that do include the SDS Enterprise Database, user accounts are managed with 
the SDS User Account Manager software. For more information, see the SDS Enterprise 
Database for the Applied Biosystems 7900HT Fast Real-Time PCR System 
Administrators Guide.

When to Perform As needed
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Enable/Disable Login

Enabling the login function allows the SDS software 
to capture user information so that the system can be 
customized for each user (user preferences).

When the login is enabled, the Login dialog box 
appears when the SDS software is started.

To enable or disable the login:

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. Select Tools Options to open the Options 
dialog box.

3. Click the General tab.

4. Select or deselect the Enable login in non-
enterprise mode check box, as desired. 

5. Click OK to save the changes and close the 
dialog box.

Add a User Account

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

4

3

5
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2. Select Tools Local User Account Manager to 
open the Local User Account Manager dialog 
box.

3. Click Add User.

4. Complete the Add Local User dialog box:
a. User Name – Enter a user name. The user 

name must begin with a letter of the 
alphabet and cannot exceed 30 characters.

b. Password/Confirm Password – Enter a 
password, then re-enter it to confirm. The 
password must begin with a letter of the 
alphabet and must be between 6 and 30 
characters long.

Note: Users can change their own 
passwords at a later time by selecting 
Tools Change Password.

c. Full Name pane – Enter the user’s First, 
Middle, and Last names. The names cannot 
exceed 50 characters.

d. User Group pane – Select an appropriate 
group for the user: Operator, 
Administrator, or Scientist.

Note: This information is not used for 
access control purposes.

e. Status pane – Select an appropriate status 
for the user: Active or Disabled.

Note: If a user has the Disabled status, the 
user cannot log into the software.

5. Click OK to save the changes and close the 
dialog box.

3

4a

4b

4c

4d

4e
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Edit a User Account

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. Select Tools Local User Account Manager to 
open the Local User Account Manager dialog 
box.

3. Select the user account you want to edit, then 
click Edit User.

4. Complete the Edit Local User dialog box:
a. Full Name pane – Enter the user’s First, 

Middle, and Last names. The names cannot 
exceed 50 characters.

b. User Group pane – Select an appropriate 
group for the user: Operator, 
Administrator, or Scientist.

Note: This information is not used for 
access control purposes.

c. Status pane – Select an appropriate status 
for the user: Active or Disabled.

Note: If a user has the Disabled status, the 
user cannot log into the software.

Note: You cannot edit a user’s name or 
password. Users can change their own passwords 
at a later time by selecting Tools Change 
Password.

5. Click OK to save the changes and close the 
dialog box.

3

4a

4b

4c
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Delete a User Account

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. Select Tools Local User Account Manager to 
open the Local User Account Manager dialog 
box.

3. Select the user account you want to delete, then 
click Delete User.

4. At the prompt, click Yes. The user account is 
removed from the Local User Account Manager.

5. Click Close to close the dialog box.

3
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Updating the SDS Software

When to Perform As needed

Upgrading the
SDS Software

Applied Biosystems continually develops the SDS software to provide increased 
functionality and reliability of the 7900HT Fast System. As updates become available, 
Applied Biosystems sends notifications of the upgrades to all Applied Biosystems 
7900HT Fast System customers. 

Review all documentation accompanying the software upgrade (such as installation 
notes or user bulletin). The updated version of the software may contain new features 
that require special consideration.

Note: Applied Biosystems service engineers perform regular SDS software updates 
during planned maintenance visits.

Reinstalling the
SDS Software

On rare occasions, when a piece of the SDS software becomes corrupt, it may be 
necessary to reinstall the software. In the event that the software must be reinstalled, 
observe the following guidelines:

• Unless instructed to do otherwise, remove the SDS software using the uninstall 
utility. Do not delete the program folder from the Program Files directory.

• Backup all data before reinstalling the SDS software.
• Reinstall the SDS software under a user login that has administrator privileges on 

the computer.
• Unless instructed to do otherwise, reinstall the SDS software to the same directory 

as the previous installation.

Updating the Operating System Software

When to Perform
Windows Service

Pack Updates

Do not upgrade the operating system of the computer connected to the 7900HT Fast 
System unless instructed to do so by an Applied Biosystems representative. New 
versions of the Windows operating system can conflict with the SDS software and 
render the instrument inoperable. 

If you want to install a service pack to update the operating system, check the release 
notes that are installed with the SDS software for compatibility issues.

Note: Applied Biosystems service engineers maintain the operating system software as 
part of planned maintenance visits. During the visit, an engineer will update the 
computer operating system as upgrades become available and are validated by Applied 
Biosystems.
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Troubleshooting Software and Computer Problems

Troubleshooting
Table

Table 3-1 Troubleshooting software and computer problems

Observation Possible Cause Recommended Action

SDS software will not start 

The software crashes/freezes 
the computer or displays an 
error message 

• Incorrect start-up 
sequence

• Corrupted software
• Computer 

hardware failure
• Operating System 

(OS) corruption
• Loose bar code 

reader cable

Follow the solutions listed until 
the symptom goes away.

1

1. Power off the 7900HT 
instrument.

2. Check cable connections.

3. Restart the computer and 
log on to the computer.

4. Power on the 7900HT 
instrument.

5. Start the SDS software.

2

6. Restart the computer and 
log on to your computer.

7. Reinstall the SDS software.

8. Start the SDS software.

3

Contact Applied Biosystems 
Service for OS problems or if 
the computer will not boot up at 
all. You may have to reload the 
OS from the CDs.

4

Contact Dell for 
troubleshooting the computer 
hardware. 

Communication error Cables are connected 
incorrectly

Check cable connections and 
COM port setup. See 
Appendix B on page 153.

Thermal cycler errors Sample block module 
not fully engaged

Reseat the sample block 
module. See “Removing and 
Installing a Sample Block” on 
page 53.

Automation Controller 
Software cannot find a plate 
document file

File not in correct 
location

Remove file entry from plate 
queue and add the file to the 
plate queue again.
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Dialog box does not respond 
to mouse clicks or key 
strokes

Java Runtime Error Click the close box of the dialog 
box to close it.

Run will not start No calibration file Perform background and pure 
dye calibrations. 

See “Performing a Background 
Calibration” on page 3 and 
“Performing a Pure Dye 
Calibration” on page 17.

No background data in 
calibration file 
(background 
calibration has not 
been performed)

No pure dye data in 
calibration file 
(pure dye run has not 
been performed)

Calibration file does 
not contain pure dye 
data for a dye used on 
the plate document

Calibration file was 
created on another 
instrument

Disk drive containing 
the plate document 
has less than 50 MB of 
free space

Check the capacity of the 
destination drive. If less than 
50 MB of free space remains, 
remove or archive existing data 
files. See “Archiving and 
Backing Up SDS Software 
Files” on page 73.

Heated cover cannot 
reach running 
temperature because 
no plate loaded

Open the instrument tray and 
check that the instrument 
contains a plate.

Instrument tray 
contains a plate

Output stack contains 
a plate or plates

Remove all plates from the 
output stack of the Plate 
Handler before starting the 
queue.

Computer is slow when 
analyzing data, opening or 
closing dialog boxes, and 
other software processes

Hard drive is 
fragmented

Defragment the hard drive. See 
“Defragmenting the Hard Drive” 
on page 76.

Hard drive is almost 
full

Remove or archive existing 
data files. See “Archiving and 
Backing Up SDS Software 
Files” on page 73.

Table 3-1 Troubleshooting software and computer problems

Observation Possible Cause Recommended Action
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The computer will not logon 
to the Windows operating 
system

Logon window does 
not appear

Restart the computer and log 
on to your computer.

You are not logged on 
as the Administrator

1. Log off of your computer.

2. Log on again as the 
Administrator.

After the above 
solutions have been 
tried, the problem is 
still not fixed

Contact Dell for 
troubleshooting the computer 
hardware or OS. 

The computer will not boot 
up at all

Cables are not 
connected or are not 
seated properly

Check the cables.

The boot disk is corrupted. 

1. Boot directly off of the 
Windows operating system 
installation CD.

2. Boot off of the emergency 
disk.

3. Reload the Windows 
operating system from the 
CD.

After the above 
solution has been 
tried, the problem is 
still not fixed

Contact Dell for 
troubleshooting the computer 
hardware. 

Table 3-1 Troubleshooting software and computer problems

Observation Possible Cause Recommended Action
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Maintaining the
Automation
Accessory

Recommended
Maintenance Schedule

Cleaning and
Replacing Gripper

Finger Pads

Automation Accessory
Components and
Stack Positions

Aligning the Plate Handler

Troubleshooting the
Automation Accessory
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Aligning the Fixed-Position
Bar Code Reader

Performing
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Troubleshooting
Chemistry and
Assay Runs

See page 97

See page 117

See page 88

See page 89

See page 90
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Recommended Maintenance Schedule
To ensure optimal performance of the Automation Accessory, perform the following 
tasks as indicated in the table below.

Schedule Maintenance Task

Monthly Inspect the gripper finger pads (see page 90)

As needed • Clean or replace the gripper finger pads (see page 90)

• Adjust the plate sensor switch (see page 92)

• Align the Plate Handler (see page 97)

• Align the fixed-position bar code reader (see page 110)

Su M T W Th F S

Month (30 Days)
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Automation Accessory Components and Stack Positions

Automation
Accessory

Components

The Automation Accessory includes the Zymark® Twister Microplate Handler and the 
fixed-position bar code reader.

Refer to the figure below for the components discussed in this section.

Plate Stack
Positions

The Zymark Twister Microplate Handler alignment is performed using the Zymark® 
Twister Software. The software refers to the positions of the plate stacks differently than 
the Automation Controller Software. The figure below lists the positions defined by the 
Zymark Twister Software and the Automation Controller Software equivalents.

Plate stack

Fixed-position bar code reader

Expansion stacks

Zymark Twister Microplate Handler
G

R
20

14
a

GripperPlate-sensor 
switch

(cross-sectional view of the gripper)

Adjustment 
knob 

0

6

7

5
4

2

1

3

Bar code

Well A1

(front of instrument) 

Zymark Twister 
Software

Automation 
Controller 
Software

Position 0 Output

Position 1 (unused)

Position 2 Instrument

Position 3 (unused)

Position 4 Stack 1
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Cleaning and Replacing Gripper Finger Pads

When to Perform The adhesive used to affix bar code labels to certain brands of microplates can build up 
on the gripper pads of the Zymark Twister Microplate Handler. Over time, the residue 
can cause the gripper pads to stick to the microplates while handling them, causing 
misfeeds. 

To prevent buildup, Applied Biosystems recommends that you:

• Inspect the gripper pads monthly
• Clean or replace the pads as needed

Before You Begin

Time Required 10 minutes

Materials
Required

You need the materials listed below to perform this procedure.

Workflow To clean and replace the gripper finger pads:

1. Obtain the tools and materials required (shown above).

2. Clean (see below) or replace (see page 91) the gripper finger pads.

Finger Pad Replacement Kit, containing 
10 finger pads (PN 4315472)

Flat-blade screwdriver, small

Phillips head screwdriver, small

Isopropanol in a squeeze bottle
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Cleaning the
Finger Pads

1. Wipe each pad thoroughly with Isopropanol until the residue has been removed.

CHEMICAL HAZARD. Isopropanol is a flammable liquid 
and vapor. It may cause eye, skin, and upper respiratory tract irritation. Prolonged 
or repeated contact may dry skin and cause irritation. It may cause central nervous 
system effects such as drowsiness, dizziness, and headache, etc. Please read the 
MSDS, and follow the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

2. If the pads appear rough or the adhesive cannot be removed, replace the pads as 
described on page 91.

Replacing the
Finger Pads

1. Using a small Phillips-head screwdriver, remove the two small Phillips-head screws 
from the fingers on each side of the gripper, then remove the fingers.

Note: Move the Plate Handler arm into any position where it is easy to access the 
screws.

2. Using a small flat-blade screwdriver, pry the worn finger pads off the fingers.

Note: The manufacturer recommends replacing all finger pads at the same time.

3. Clean any residual adhesive off the fingers using isopropanol.

CHEMICAL HAZARD. Isopropanol is a flammable liquid 
and vapor. It may cause eye, skin, and upper respiratory tract irritation. Prolonged 
or repeated contact may dry skin and cause irritation. It may cause central nervous 
system effects such as drowsiness, dizziness, and headache, etc. Please read the 
MSDS, and follow the handling instructions. Wear appropriate protective eyewear, 
clothing, and gloves.

4. Remove a replacement finger pad from the paper backing, then place the finger pad 
on the appropriate finger position.

5. Repeat step 4 for the remaining finger pads.

6. Install the fingers with the fingers pointing down and the finger pads toward the 
center of the gripper.

7. Insert the screws into the fingers and tighten.

Note: The screws do not automatically align the grippers. Make sure that the finger 
pads are making good contact with the plate when the Plate Handler arm grips a 
plate.
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Adjusting the Plate Sensor Switch

When to Perform Adjust the plate sensor switch (located underneath the arm of the Plate Handler):

• After changing the sample block format (for example, replacing a Standard 384-
Well Block with a Standard 96-Well Block)

Note: The Automation Accessory should not be used for running Fast 96-well 
reaction plates.

Note: The various plate types have different dimensions, which can affect the way 
the Plate Handler grips the plates. Adjusting the plate sensor switch after changing 
sample block formats ensures smooth operation of the Automation Accessory.

• If the Plate Handler is having difficulty sensing plates

Before You Begin

Time Required 20 minutes

Materials
Required

You need the materials listed below to perform this procedure.

Workflow To adjust the plate sensor switch:

1. Obtain the tools and materials required (shown above).

2. Adjust the plate sensor switch (see page 93).

3. Test the adjustment (see page 95).

4. Confirm the Zymark Twister Software is closed (see page 96).

Appropriate plate type for your current 
sample block; one of the following:

• Standard 384-well reaction plate

• Standard 96-well reaction plate

• TaqMan® Low Density Array

Note: The Automation Accessory should not 
be used for running Fast 96-well reaction 
plates.
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Pictured: Standard 384-well reaction plate



Chapter 4 Maintaining the Automation Accessory
Adjusting the Plate Sensor Switch

7900HT Fast System Maintenance and Troubleshooting Guide 93

Notes

4

Adjusting the Plate Sensor Switch

1. Power off the Zymark Twister Microplate 
Handler.

PHYSICAL HAZARD. 
The Zymark Twister Microplate Handler must be 
powered off at all times during the following 
procedure. Failure to comply can result in 
physical injury to the user or damage to the Plate 
Handler.

2. Clear the switch position by turning the thumb 
wheel all the way to the Up extreme (as indicated 
on the side panel).

3. Begin the adjustment of the sensor switch:
a. Grasp a plate by the sides, making sure not 

to place pressure in the center of the plate to 
deform it. 

b. Place the plate between the fingers of the 
gripper assembly and align it to the middle 
of the centering device. 

c. While holding the plate in position, slowly 
turn the thumb wheel to lower the switch 
onto the plate until the switch:

• Contacts the top of the plate, and 
• Emits a soft, audible “clicking” noise

IMPORTANT! The sound emitted by the 
sensor switch is very faint and may be 
difficult to hear. To make the adjustment 
easier, place your ear close to the sensor 
switch while making the adjustment and 
listen for the switch to engage.

G
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4. Remove the plate and listen for the plate sensor switch to disengage. 

5. After the zero point is established, carefully turn the thumb wheel in the Down 
direction the number of steps appropriate for your plate type, as indicated below: 

Note: If you lose count, begin again from step 4 and identify the zero point for the 
switch.

Did you hear the 
switch disengage? Then…

No a. Move the switch Down a few steps by turning the thumb 
wheel in the direction indicated on the arm. 

b. Replace the plate inside the gripper and listen for the 
switch to engage:

– If you do not hear the switch engage, then remove the 
plate and repeat steps a and b above.

– If you hear the switch engage, remove the plate and 
continue to step a below.

Yes a. Move the switch Up by turning the thumb wheel one step 
in the direction indicated on the arm. 

b. Replace the plate and listen for the switch to engage:

– If you hear the switch engage, remove the plate and 
repeat steps a and b above.

– If you do not hear the switch engage, then you have 
successfully identified the zero point of the plate sensor 
switch. 

Note: At the zero point, one step of the thumb wheel in the 
Down direction causes the switch to engage.

Plate Turn the thumb wheel in the Down direction…

Standard 384-well reaction 
plate

15 steps

Standard 96-well reaction 
plate

20 steps

TaqMan Low Density Array 15 steps
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Testing the Adjustment

1. Place the plate in the input stack 1 of the Plate 
Handler.

2. Power on the 7900HT Fast System, the Plate 
Handler, and the computer.

3. Select Start > Programs > Zymark Twister 
Plate Handler > Twister to start the Zymark 
Twister Software.

4. Click Manual Control to open the Manual 
Control dialog box.

5. Click stack 4. The Plate Handler arm moves over 
the input stack.

6. Click .
• If the adjustment was successful, the Plate 

Handler arm will lower upon the plate until 
the plate sensor switch engages, confirming 
the presence of the plate. 

• If the Plate Handler arm emits a grinding 
sound, adjust the plate sensor switch:

a. In the Zymark Twister Software, click 
 to raise the Plate Handler arm. 

b. Turn the thumbscrew in the Down direction 
10 steps.

c. Repeat step 6 until the Plate Handler arm 
successfully detects the plate. 

Click
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7. Click , then click .
• If the adjustment was successful, the Plate Handler arm will grasp the plate and 

remove it from the plate stack. 
• If the Plate Handler arm stops before the gripper fingers are able to contact the 

plate and fails to grasp or pick up the plate, adjust the plate sensor switch:
a. Turn the thumbscrew in the Up direction 10 steps.
b. Grasp the plate with one hand and, from the Zymark Twister Software, click 

 to release the plate.
c. Replace the reaction plate into input stack 1 of the Plate Handler.

8. Repeat steps 6 through 7 until the Plate Handler arm successfully retrieves the 
plate. 

9. Grasp the plate with one hand and, from the Zymark Twister Software, 
click  to release the plate.

10. Exit the Zymark Twister Software:
a. Click .
b. Click Quit Application to close the software. 

Confirm the
Zymark Twister

Software Is
Closed

A defect in the Zymark Twister Software can cause portions of the program to persist in 
memory even after the software has been closed. Because the Zymark Twister Software 
conflicts with the SDS software, the residual elements of the Zymark Twister Software 
must be closed inside the Microsoft Windows® operating system Task Manager before 
continuing.

1. Press the Crtl + Alt + Del keys in unison to open the Windows operating system 
Security dialog box.

2. Click Task Manager to open the Windows operating system Task Manager dialog 
box.

3. Click the Applications tab.

4. Confirm that the software has closed by looking for the Zymark Twister Software 
entry in the Task list. 

• If the software is completely closed, there is no entry for the Zymark Twister 
Software.

• If the software is still running, click the Zymark Twister Software entry to 
select it, then click End Task.

5. Close the Task Manager dialog box.
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Aligning the Plate Handler

When to Perform Align the Zymark Twister Microplate Handler if:

• You move the Applied Biosystems 7900HT Fast Real-Time PCR System
• The Plate Handler is misaligned

Symptoms that the Plate Handler is out of alignment include: 
– Excessive downward movement of the Plate Handler arm (the arm grinds when 

grasping or releasing plates)
– The Plate Handler arm collides with the plate stacks
– The Plate Handler arm releases plates above the bottom of the plate stacks
– Plates tip or tilt when placed into the instrument tray by the Plate Handler arm

Before You Begin

Time Required 30 minutes

Materials
Required

You need the materials listed below to perform this procedure.

Appropriate plate type for your current 
sample block; one of the following:

• Standard 384-well reaction plate

• Standard 96-well reaction plate

• TaqMan® Low Density Array

Note: The Automation Accessory should not 
be used for running Fast 96-well reaction 
plates.
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Pictured: Standard 384-well reaction plate
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Workflow To align the plate handler:

1. Obtain the tools and materials required (shown above).

2. Prepare the 7900HT instrument (see page 99).

3. Align input stack 1 (see page 100).

4. Align the Plate Handler to the 7900HT instrument (see page 102).

5. Recheck input stack 1 (see page 104).

6. Define the bottom of the stack (see page 105).

7. Define the positions of the remaining stacks (see page 107).

8. Confirm the Zymark Twister Software is closed (see page 108).
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Preparing the Instrument for the Alignment 

1. Remove the covers for the fixed-position bar 
code reader and the underlying platform.

2. Loosen the three black thumbscrews on the 
platform connecting the 7900HT Fast System 
and the Plate Handler base.

3. Power on the 7900HT Fast System, the Plate 
Handler, and the computer.

4. Move the instrument tray to the OUT position:
a. Double-click  on the desktop (or select 

Start > All Programs > Applied 
Biosystems > SDS 2.3 > SDS Automation 
Controller 2.3) to start the Automation 
Controller Software.

Note: If an error dialog box appears 
reading, Machine calibration values are 
not valid. Please refer to documentation 
for calibration process, click .

b. Click Open/Close Door. The 7900HT Fast 
System moves the instrument tray to the 
OUT position.

c. Select File > Exit to close the Automation 
Controller Software.

5. Select Start > Programs > Zymark Twister 
Plate Handler > Twister to start the Zymark 
Twister Software.

6. Click Manual Control to open the Manual 
Control dialog box.

GR2009
7900HT
Front view with Robot

7900HT FAST Real-Time PCR System

GR2009

Fixed-position bar code reader and 
underlying platform covers

Black thumbscrews
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Aligning Input Stack 1 (Zymark Position 4)

The alignment of input stack 1 (position 4 in the 
Zymark Twister Software) is the first step in the 
alignment procedure. This alignment provides the 
basis for aligning all subsequent stacks on the Plate 
Handler.

1. Place an empty plate into input stack 1 (Zymark 
position 4).

2. In the Zymark Twister Software, click position 4. 
The Plate Handler arm moves over the input 
stack. 

3. Using the Vertical Positioning commands, lower 
the Plate Handler arm until it is just above the 
stack. The Vertical Positioning commands 
provide five ways to move the Plate Handler 
arm:

• Move the slider for large increments.
• Click inside the slider bar to move the arm 

in 250-step increments.
• Click the lower arrow on the bar to move 

the arm in 50-step increments.
• Click the up or down arrows in the Vertical 

Adjustment text box to move the arm in 
1-step increments.

• Click the Vertical Adjustment text box, 
enter a value, then press Enter to move the 
arm into a specific location.

Click

Slider

Slider bar (250 steps 
per click)

Down arrow (50 steps 
per click)

Text box arrows (1 step per 
click) or manual entry
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4. Using the Rotary Adjustment arrows, adjust the 
rotational position of the gripper so that it is 
centered over the input stack and will not contact 
the sides when lowered. 

• To move the Plate Handler arm clockwise, 
click the up arrow.

• To move the Plate Handler arm counter-
clockwise, click the down arrow.

5. Using the Vertical Positioning commands, 
carefully lower the Plate Handler arm into the 
stack. Change the Rotary Adjustment value as 
needed to center the gripper inside the stack.

6. After the gripper is centered inside the stack, 
click  to lower the Plate Handler arm 
on the plate.

7. Confirm the following:
• The plate is in the middle of the gripper 

span
• The plate sensor switch is contacting the 

plate
• The gripper and plate do not contact the side 

of the stack

8. Click . The gripper grips the plate 
between its fingers.

9. Select . The Plate Handler raises the 
arm to its highest position. If the plate contacts 
the sides of the stack, readjust the rotary position 
of the Plate Handler arm until the plate moves 
freely in the stack.

Note: Contact between the plate and the stack or 
all stacks may be unavoidable. However, try to 
minimize the contact as much as possible.

10. Using the Vertical Positioning commands, raise 
and lower the Plate Handler arm several times to 
check the alignment.

Up arrow (moves the arm 
clockwise)

Down arrow (moves the arm 
counter-clockwise)
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11. Lower the Plate Handler arm to the bottom of the 
plate stack, click , then click . 
The software records the rotary position for the 
Zymark position 4 (input stack 1).

12. Click . The gripper releases the 
plate.

Aligning the Plate Handler to the 
Instrument Tray

The next step is to align the Plate Handler arm to the 
instrument tray (Zymark position 2). This alignment 
will ensure a smooth exchange between the Plate 
Handler arm and the instrument tray during 
instrument operation.

1. If not already present, place an empty plate into 
input stack 1 (Zymark position 4) and pick it up 
with the Plate Handler arm:

a. In the Zymark Twister Software, click 
position 4.

b. Click .
c. Click .

2. Click position 2. The Plate Handler arm moves 
over the instrument tray.

3. Using the Vertical Positioning commands, lower 
the Plate Handler arm until it is approximately 
1 cm above the instrument tray.

Click here

Slider

Slider bar (250 steps 
per click)

Down arrow (50 steps 
per click)

Text box arrows (1 step per 
click) or manual entry
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4. Using the Rotary Adjustment arrows, center the 
gripper and plate along the Y-axis of the 
instrument tray.

5. Center the gripper and plate along the X-axis of 
the instrument tray by sliding the Plate Handler 
and base towards or away from the 7900HT Fast 
System.

6. Again using the Rotary Adjustment arrows, 
center the gripper and plate along the Y-axis of 
the instrument tray, as shown in step 4 above.

7. Using the Vertical Positioning commands, 
carefully lower the Plate Handler arm onto the 
instrument tray and confirm that the plate rests 
squarely inside it.

8. Tighten the three black thumbscrews on the 
platform connecting the 7900HT Fast System 
and the Plate Handler.

9. Release the plate from the Plate Handler arm:
a. Click .
b. Click .

Up arrow (moves the arm 
clockwise)

Down arrow (moves the arm 
counter-clockwise)
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10. Click . The Plate Handler arm lowers 
onto the plate.

11. Save the rotary and vertical offset information:
a. Click , then click . The 

software records the rotary position for the 
plate drawer (Zymark position 2).

b. Click , then click . The 
software records the vertical position for the 
plate drawer.

Rechecking the Input Stack 1 

Now that the positions of the Plate Handler and 
instrument are fixed, the Plate Handler stacks can be 
aligned and the positional values recorded.

1. If not already present, place an empty plate into 
input stack 1 (Zymark position 4).

2. In the Zymark Twister Software, click position 4. 
The Plate Handler arm moves over the input 
stack.

3. Using the Vertical Positioning commands, lower 
the Plate Handler arm until it is 1 cm above the 
stack and verify that it is centered on the stack. If 
necessary, center the stack using the Rotary 
Adjustment arrows. 

4. Carefully lower the Plate Handler arm into the 
stack. Center the gripper as it moves down the 
stack by adjusting the Rotary Adjustment arrows 
if needed. 

5. After the Plate Handler arm is centered inside the 
stack, click . The Plate Handler arm 
lowers upon the plate.

Click
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6. Confirm the following:
• The plate is in the middle of the gripper span.
• The plate sensor switch is contacting the plate.
• The gripper does not contact the side of the stack.

7. Click .

8. Click . The Plate Handler raises the arm to its highest position. If the 
plate contacts the sides of the stack, re-adjust the rotary position of the Plate 
Handler arm until the plate moves freely inside the stack.

Note: Contact between the plate and the stack or all stacks may be unavoidable. 
However, try to minimize the contact as much as possible.

9. Click , then click . The software re-records the rotary position for 
input stack 1 (Zymark position 4).

10. While holding the plate, click  and remove the plate.

Defining the
Bottom of the

Stack

The Automation Controller Software requires a bottom position value for all stacks. This 
value is used to prevent the Plate Handler arm from colliding or grinding as it moves to 
the bottom of each stack.

1. Remove all plates from the instrument and the Plate Handler arm.

2. Place an empty plate into the output stack (Zymark position 0).

3. In the Zymark Twister Software, click position 0. The Plate Handler arm moves 
over the output stack. 

4. Using the Vertical Positioning commands, lower the Plate Handler arm until it is 
just above the stack.

5. Using the Rotary Adjustment arrows, adjust the rotational position of the gripper so 
that it is centered over the input stack and will not contact the sides when lowered. 

6. Using the Vertical Positioning commands, carefully lower the Plate Handler arm 
into the stack. Change the Rotary Adjustment value as needed to center the gripper 
inside the stack.

7. After the gripper is centered inside the stack, click . The Plate Handler 
arm lowers upon the plate.
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8. Confirm the following:
• The plate is in the middle of the gripper span
• The plate sensor switch is contacting the plate
• The gripper does not contact the side of the stack

9. Click . The gripper grips the plate between its fingers.

10. Select . The Plate Handler raises the arm to its highest position. If the 
plate contacts the sides of the stack, readjust the rotary position of the Plate Handler 
arm until the plate moves freely in the stack.

Note: Contact between the plate and the stack may be unavoidable. However, try to 
minimize the contact as much as possible.

11. Using the Vertical Positioning commands, raise and lower Plate Handler arm 
several times to check the alignment.

12. Lower the Plate Handler arm, click , then click . The software 
records the rotary position for position 0 (the output stack).

13. Click the .

14. While holding the plate, click  and remove the plate.

15. In the Vertical Adjustment field, enter –3200, then press Enter. The Plate Handler 
lowers the arm to a position near the base of the output stack.

16. Carefully lower the Plate Handler arm until it is approximately 1–2 mm from the 
bottom of the stack.

17. Click , click , then record the number in the Vertical Adjustment 
field. The software records the vertical position for position 0 (the output stack).

18. Click . The Plate Handler raises the Plate Handler arm to its highest 
position. 

19. In the Vertical Adjustment field, enter the Vertical Offset value determined in 
step 17, and press Enter. The Plate Handler lowers the Plate Handler arm to a 
Vertical Offset position.

20. If necessary, readjust the Vertical Offset value and repeat steps 18 through 19 until 
satisfied with the setting.
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Defining the
Positions of the

Remaining Stacks

1. Place an empty plate into input stack 2 (Zymark position 5).

2. In the Zymark Twister Software, click position 5. The Plate Handler arm moves 
over the input stack. 

3. Using the Vertical Positioning commands, lower the Plate Handler arm until it is 
approximately 1 cm above the stack, then center it using the Rotary Adjustment 
arrows. 

4. Carefully lower the Plate Handler arm into the stack. Center the gripper as it moves 
down the stack by adjusting the Rotary Adjustment arrows as needed. 

5. After the Plate Handler arm is centered inside the stack, click . The 
Plate Handler arm lowers upon the plate.

6. Confirm the following:
• The plate is in the middle of the gripper span.
• The plate sensor switch is contacting the plate.
• The gripper does not contact the side of the stack.

7. Click .

8. Click . The Plate Handler arm raises to its highest position. If the plate 
contacts the sides of the stack, readjust the rotary position of the Plate Handler arm 
until the plate moves freely in the stack.

Note: Contact between the plate and the stack may be unavoidable. However, try to 
minimize the contact as much as possible.

9. Using the Vertical Positioning commands, raise and lower Plate Handler arm 
several times to check the alignment.

10. Click , and click . The software records the rotary position for the 
Zymark position 5 (input stack 2).
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11. Repeat steps 1 through 10 for input stacks 3 and 
4 to define Rotary Offset values for the 
remaining positions 6 and 7.

12. Exit the Zymark Twister Software:
a. Click .
b. Click Quit Application to close the 

software. 

13. Replace the covers for the fixed-position bar 
code reader and the underlying platform 
(removed in step 1 on page 99).

Confirm the Zymark Twister Software Is 
Closed

A defect in the Zymark Twister Software can cause 
portions of the program to persist in memory even 
after the software has been closed. Because the 
Zymark Twister Software conflicts with the SDS 
software, the residual elements of the Zymark Twister 
Software must be closed inside the Windows 
operating system Task Manager before continuing.

1. Press the Crtl + Alt + Del keys in unison to open 
the Windows operating system Security dialog 
box.

2. Click Task Manager to open the Windows 
operating system Task Manager dialog box.

3. Click the Applications tab.

Zymark position 6 
(input stack 3)

Zymark position 7 
(input stack 4)

GR2009
7900HT
Front view with Robot

7900HT FAST Real-Time PCR System

GR2009

Fixed-position bar code reader and 
underlying platform covers
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4. Confirm that the software has closed by looking 
for the Zymark Twister Software entry in the 
Task list. 

• If the software is completely closed, there is 
no entry for the Zymark Twister Software.

• If the software is still running, click the 
Zymark Twister Software entry to select it, 
then click End Task.

5. Close the Task Manager dialog box.
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Aligning the Fixed-Position Bar Code Reader

Two Bar Code
Readers

Two bar code readers are available for the 7900HT Fast System:

• CLV Fixed-Position Bar Code Reader
• LD Fixed-Position Bar Code Reader

This section provides procedures for aligning both bar code readers.

When to Perform The fixed-position bar code reader must be set so that it automatically scans the plate’s 
bar code as the plate is placed into the instrument tray by the Plate Handler.

Align the fixed-position bar code reader:

• Whenever the Automation Accessory platform is moved from its calibrated position 
(for example, during Service visits)

Before You Begin

Time Required 20 minutes

Materials
Required

You need the materials listed below to perform this procedure.

Workflow To align the fixed-position bar code reader:

1. Obtain the tools and materials required (shown above).

2. Prepare the 7900HT instrument (see page 111).

3. Align the fixed-position bar code reader. Be sure to follow the right alignment 
procedure for your bar code reader:

• “Aligning the CLV Fixed-Position Bar Code Reader” on page 112, or
• “Aligning the LD Fixed-Position Bar Code Reader” on page 114

Appropriate plate type for your current 
sample block; one of the following:

• Standard 384-well reaction plate

• Standard 96-well reaction plate

• TaqMan® Low Density Array

Note: The Automation Accessory should not 
be used for running Fast 96-well reaction 
plates.
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Pictured: Standard 384-well reaction plate
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Preparing the Instrument for the Alignment

1. Remove the cover for the fixed-position bar code 
reader.

2. Power on the 7900HT Fast System and the 
computer.

3. Move the instrument tray to the OUT position:
a. Double-click  on the desktop (or select 

Start > All Programs > Applied 
Biosystems > SDS 2.3 > SDS Automation 
Controller 2.3) to start the Automation 
Controller Software.

Note: If an error dialog box appears 
reading, Machine calibration values are 
not valid. Please refer to documentation 
for calibration process, click .

b. Click Open/Close Door. The 7900HT Fast 
System moves the instrument tray to the 
OUT position.

c. Select File > Exit to close the Automation 
Controller Software.

4. Continue with:
• “Aligning the CLV Fixed-Position 

Bar Code Reader” on page 112, or
• “Aligning the LD Fixed-Position Bar Code 

Reader” on page 114

GR2009
7900HT
Front view with Robot

7900HT FAST Real-Time PCR System

GR2009

Fixed-position bar code reader cover
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Aligning the CLV Fixed-Position Bar Code 
Reader

Note: This procedure is for the CLV Fixed-Position 
Bar Code Reader. If you are aligning the LD Fixed-
Position Bar Code Reader, see page 114.

IMPORTANT! The instrument tray must be in the 
OUT position to align the bar code reader.

1. Place a plate with bar code onto the instrument 
tray.

IMPORTANT! Orient the plate so that well A1 
aligns to the A1 position of the instrument tray 
and that the bar code faces the fixed-position bar 
code reader.

2. Select Start > All Programs > CLV Setup v 
4.1 to start the CLV software.

3. In the CLV Setup window:
a. Click the Device drop-down list and select 

CLV42x.
b. Click  (Terminal) to open the Terminal 

dialog box.
G

R
20
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Well position A1

Bar code

3b 3a
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4. In the Terminal dialog box, select Percent 
Evaluation.

5. Loosen the black positional adjustment knob on 
the fixed-position bar code reader, and position 
the scan head of the reader as far as possible 
from the plate while maintaining the orientation 
towards the bar code on the plate.

6. While watching the Terminal dialog box, slowly 
adjust the orientation of the fixed-position bar 
code reader until the Terminal dialog box reads 
more than 20%.

Note: The Percent Evaluation depends on how 
many lines hit the bar code label.

Note: It may be helpful to briefly place a sheet 
of white paper in front of the plate bar code to 
view the area scanned by the laser.

7. When satisfied with the alignment, tighten the 
black positional adjustment knob on the fixed-
position bar code reader.

8. Click Exit to close the Terminal dialog box, then 
close the CLV software.

9. Replace the cover for the fixed-position bar code 
reader (removed in step 1 on page 111).

G
R
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Black positional 
adjustment knob

Scan head of the fixed-
position bar code reader
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Aligning the LD Fixed-Position Bar Code 
Reader

Note: This procedure is for the LD Fixed-Position 
Bar Code Reader. If you are aligning the CLV Fixed-
Position Bar Code Reader, see page 112.

IMPORTANT! The instrument tray must be in the 
OUT position to align the bar code reader.

1. Place a plate with bar code onto the instrument 
tray.

IMPORTANT! Orient the plate so that well A1 
aligns to the A1 position of the instrument tray 
and that the bar code faces the fixed-position bar 
code reader.

2. Select Start > All Programs > PSC Laser 
Data > LDHOST to start the LDHOST 
software.

3. Establish communication with the fixed-position 
bar code reader:

a. Click  (Edit) to open the Edit 
Configuration dialog box.

b. Click  (Terminal) to open the Terminal 
dialog box.

c. In the Device Control dialog box, click  
(Connect to Device). The Terminal dialog 
box displays the fixed-position bar code 
reader response.

d. Click  to close the information 
message.

The LD Host program communicates with the 
bar code reader and updates the Edit 
Configuration dialog box with the current 
configuration settings.

G
R

20
18

Well position A1

Bar code
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4. Configure the software for the alignment:

a. In the bottom of the Edit Configuration 
dialog box, locate and select the Op. Modes 
tab.

Note: You may need to use the arrows 
located in the bottom of the dialog box to 
locate the Op. Modes tab.

b. In the Operating modes selection pane of 
the Edit Configuration dialog box, click the 
Mode drop-down list and select Test.

c. In the Device Control dialog box, click 
RAM to toggle to EEPROM mode, then 
click Send.

d. In the Confirm dialog box, click YES to 
save to EEPROM.

The fixed-position bar code reader begins a 
continuous repeating scan of the bar code. The 
software updates the Terminal dialog box every 
0.5 sec indicating the percentage of accurate 
reads completed during the 0.5 sec interval.

5. Loosen the black positional adjustment knob on 
the fixed-position bar code reader, and position 
the scan head of the reader as far as possible 
from the plate while maintaining the orientation 
towards the bar code on the plate.

Op. Modes tab

Mode drop-down list

RAM button

G
R

20
18

Black positional 
adjustment knob

Scan head of the fixed-
position bar code reader
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6. While watching the Terminal dialog box, slowly 
adjust the orientation of the fixed-position bar 
code reader until the percent successful reading 
displays the highest number possible. 

Note: It may be helpful to briefly place a sheet 
of white paper in front of the plate bar code to 
view the area scanned by the laser.

7. When satisfied with the alignment, tighten the 
black positional adjustment knob on the fixed-
position bar code reader.

8. Restore the fixed-position bar code reader to 
normal operation:

a. In the Operating modes selection pane of 
the Edit Configuration dialog box, click the 
Mode drop-down list and select 
Serial on Line.

b. In the Device Control dialog box, confirm 
that EEPROM is still selected, then click 
Send.

c. In the New Decision dialog box, click YES 
to save to EEPROM. 

The bar code reader stops scanning the plate bar 
code and resumes normal operation.

9. Click  (Exit) to close the LDHOST software.

10. Replace the cover for the fixed-position bar code 
reader (removed in step 1 on page 111).

Percent 
successful 
reads

Mode drop-down list
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Troubleshooting the Automation Accessory

Troubleshooting
Table Table 4-2 Troubleshooting the Automation Accessory

Observation Possible Cause Recommended Action

Plate Handler emits 
grinding noise when 
picking up or putting down 
plates

Vertical offset too low Re-align the Plate Handler as 
explained in “Aligning the Plate 
Handler” on page 97.Plate detector switch set 

too high

Plate Handler arm contacts 
racks when retrieving or 
stacking plates

Plate Handler rotary offset 
is incorrect or vertical offset 
is too low

The Plate Handler arm 
releases plates awkwardly 
into the plate racks

Reaction plates tip or tilt 
when placed into the 
instrument tray by the Plate 
Handler arm

Plate Handler fails to sense 
or grasp plates

Plate sensor switch not 
adjusted properly 

Adjust the plate sensor switch as 
explained in “Adjusting the Plate 
Sensor Switch” on page 92.

Gripper pads on the fingers 
of the Plate Handler arm 
are worn or dirty

Change the gripper pads as 
explained in “Cleaning and 
Replacing Gripper Finger Pads” 
on page 90.

Plates stick to the gripper 
fingers of the Plate Handler 
arm

Gripper pads are worn or 
dirty

Change the gripper pads as 
explained in “Cleaning and 
Replacing Gripper Finger Pads” 
on page 90.

Plate Handler does not 
restack plates in original 
locations

Restack when finished 
option not selected

Configure the Automation 
Controller Software to restack 
the plates. See the Sequence 
Detection Systems Software 
version 2.3 Online Help (SDS 
Online Help).

Fixed-position bar code 
reader not reading plate 
bar codes

Bar code reader is 
misaligned

Re-align the fixed-position bar 
code reader as explained in 
“Aligning the Fixed-Position Bar 
Code Reader” on page 110.Bar code reader is broken
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Low Precision or Irreproducibility

Overview There are various reasons why an assay run with the Applied Biosystems 7900HT Fast 
Real-Time PCR System can have less than optimal precision. Factors that can affect 
precision are described in detail below.

Improper Threshold Setting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  120
Imprecise Pipetting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Non-Optimized Chemistry . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Incomplete Mixing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Air Bubbles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Splashing PCR Reagents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Drops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Writing on the Reaction Plates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Fluorescent Contamination on the Plates . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Errors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Contaminated Sample Block  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  122
Improper or Damaged Plastics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  123
Low Copy Templates  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  123
Use of Non-Applied Biosystems PCR Reagents . . . . . . . . . . . . . . . . . . . . . . . . .  123

Improper
Threshold Setting

The key to high-precision quantitative PCR is accurate detection of the exponential 
(geometric) phase. The Applied Biosystems 7900HT Fast Real-Time PCR System 
typically delivers sufficient sensitivity so that at least three cycles of the geometric phase 
are visible, assuming reasonably optimized PCR conditions. The SDS software 
calculates a fixed signal intensity, called a threshold, that each signal generated from 
PCR amplification must reach before it is recognized by the software as actual 
amplification. The calculated threshold is an approximation, and should be examined 
and modified as needed.

Modifying the Threshold

In a real-time document of the SDS software, the threshold can be modified via the 
Amplification Plot view following analysis of the run data. See the Sequence Detection 
Systems Software version 2.3 Online Help (SDS Online Help) for more information.
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Imprecise
Pipetting

The calculated quantities of target nucleic acid are directly affected by how precisely the 
template or reagent volumes are added to the reaction mixes.

Using Master Reaction Mixes

Applied Biosystems highly recommends using a master reaction mixture. Mix all 
common components (including the same template) to a set of reactions together, then 
dispense the mix to the replicate wells of the plate. When making each master reaction 
mix, add 5–10% additional volume to compensate for pipetting losses.

Using Pipettors

Pipetting precision is also improved by:

• Calibrating and servicing the pipettors regularly
• Pipetting larger volumes
• Reducing the number of pipetting steps whenever possible
• Increasing the consistency of the pipetting method

Consult the manufacturer about the correct method of dispensing liquid volumes 
accurately from the pipettor. For example, some pipettors are designed to deliver the 
designated volume at the first plunger stop, so ‘blowing out’ the residue may cause error. 
Also, before using a new pipettor tip to serially dispense a master reaction mix, wet the 
tip once by drawing up some of the master reaction mix and dispensing it back into the 
mix again.

Non-Optimized
Chemistry

Chemistries that have not been optimized may be susceptible to inconsistencies. To 
maximize precision and reaction efficiency, optimize the primer and probe 
concentrations of each individual assay used. Refer to the TaqMan® Universal PCR 
Master Mix Protocol (PN 4304449) for specific information about optimizing probe and 
primer concentrations for TaqMan-related chemistries.

Note: TaqMan® Gene Expression Assays, TaqMan® SNP Genotyping Assays, and 
Custom TaqMan® SNP Genotyping Assays do not require optimization.

Incomplete
Mixing

For maximum precision, the PCR master reaction mix must be uniform. After adding all 
reaction components to the mix, vortex the mix for 4–5 seconds before aliquoting it to 
the wells of the plate. Also vortex any dilutions performed during the assay.

Air Bubbles Air bubbles in the wells can refract and distort the fluorescent signals. Ideally, the 
reagents would be applied to the wells using a pipetting technique that does not form air 
bubbles. However, if a plate does contain air bubbles, they can usually be removed by 
swinging, tapping, or briefly centrifuging the reaction plate. 

Splashing PCR
Reagents

If PCR reagents splash the undersides of the optical adhesive covers, the heat from the 
lid may bake the liquid to the cover and may distort the signal. If splashing occurs, 
briefly centrifuge the reaction plate to remove all traces of liquid from the caps.
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Drops Drops of reagents that cling to the sides of the wells may not contact the thermal cycler 
sample block and consequently may not amplify. If the drop slides into the mix during 
PCR, then the amplified products will become diluted and the result will be less than 
replicate wells that did not have drops. Therefore, carefully monitor the reaction plate as 
it is being transferred into the thermal cycler or 7900HT Fast System. If you observe any 
drops, take steps to remove them, such as centrifugation.

Writing on the
Reaction Plates

Do not write on any surface of the optical plates or the optical adhesive covers. The 
fluorescent properties of the ink can potentially affect the fluorescence emission from 
the plate and alter the results. Instead, note the contents of each well on a sheet of paper, 
or on a printout of the sample setup.

Fluorescent
Contamination on

the Plates

Many compounds found in laboratories are fluorescent. If they come into contact with 
certain optical surfaces, such as the optical adhesive covers, the fluorescent results may 
be affected. For example, it has been noted that the powder used to lubricate the insides 
of plastic gloves often contains fluorescent compounds. Use only powder-free gloves 
and do not needlessly touch the reaction plates or optical adhesive seals.

Errors Human errors from time to time are inevitable, such as pipetting into the wrong well, or 
making a dilution mistake. 

Human error can be reduced in the following ways:

• Perform the assay in a systematic fashion. For example, the pattern of sample 
positions should be simple (avoid putting gaps in the rows). 

• When pipetting the master reaction mix, look directly down into the reaction plate 
so that you can verify the transfer of the solution.

• If adding a small-volume reagent, such as template, place the drop of liquid on the 
side of the well. Briefly tap or centrifuge the plate afterwards to bring the droplet 
down into the well.

• After all pipetting is complete, visually inspect all the wells to confirm the presence 
of the reagent drops. Tapping or centrifuging the reaction plate will cause all the 
drops to slide down into the wells simultaneously.

• When making serial dilutions, be sure to change the pipet tip after each dilution 
step. 

• Visually inspect the liquid volumes being pipetted to verify that the volume is 
approximately correct. A common mistake is using the wrong pipettor volume 
setting (such as setting 20 µL instead of 2.0 µL).

• Visually inspect the volumes of the completed reactions, looking for any wells that 
have volumes that do not match those of the other wells.

Contaminated
Sample Block

Any material contaminating the sample block can affect the results. For example, 
mineral oil reduces thermal transfer. Residue from writing on reaction plates darkens the 
wells, absorbing light. 
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The sample blocks should be periodically inspected for cleanliness. Sample block 
contamination can be visualized by running a background plate and inspecting the 
resulting background signal for aberrant peaks above 4000 FSU (see page 15). See 
page 65 for instructions on decontaminating the sample block.

Improper or
Damaged Plastics

Applied Biosystems recommends that you use Applied Biosystems optical plates, optical 
adhesive covers, and optical flat caps with the 7900HT Fast System. The plastics that 
comprise the optical parts undergo special testing for the absence of fluorescent 
impurities. Optical plates are frosted to improve the degree and precision of light 
reflection. Bent, creased, or damaged plastics may adversely affect the transmission of 
fluorescent signal or prevent proper sealing of a well resulting in evaporation, change in 
sample volume, and altered PCR chemistry. Make sure to use the correct plastics and 
visually inspect each reaction plate before use.

Note: See Appendix C, “Parts and Consumables,” on page 157 for a list of compatible 
consumables and reagents.

Low Copy
Templates

When amplifying samples that contain very low quantities of nucleic acid (generally less 
than 100 molecules), expect lowered precision due to the Poisson distribution and 
biochemical effects related to binding probabilities. Low copy templates are also more 
susceptible to losses due to non-specific adhesion to plastic wells, pipettor tips, etc. The 
addition of carrier to the sample, such as yeast tRNA or glycogen, can help prevent these 
losses, increasing the precision and sensitivity of the assay.

Use of Non-
Applied

Biosystems PCR
Reagents

The Applied Biosystems buffer contains an internal passive reference molecule 
(ROX™ dye), which acts as a normalization factor for fluorescent emissions detected in 
the samples. 

IMPORTANT! Non-Applied Biosystems PCR buffers may not contain the ROX passive 
reference dye. If running non-Applied Biosystems chemistry, be sure to set the passive 
reference for your experiment as explained below.

Setting the Passive Reference

1. Open the appropriate plate document in the SDS software.

2. Select the Setup tab.

3. From the Passive Reference drop-down list, select the appropriate passive reference 
dye.
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Standard Curve (AQ) and Comparative CT (RQ) Quantitative 
Assay Runs

Troubleshooting
Analyzed Data

When faced with irregular data, you can use the SDS software to diagnose some 
chemistry- and instrument-related problems. The following table contains a summary of 
checks for verifying the integrity of your run data and to help you begin troubleshooting 
potential problems.

Raw Data Plot The Raw Data Plot displays the raw reporter fluorescence signal (not normalized) for the 
selected wells during each cycle of the real-time PCR.

What to look for:

• Signal tightness and uniformity – Do the raw spectra signals from replicate 
groups and controls exhibit similar spectral ‘profiles’? If not, the plate or sample 
block could be contaminated.

• Characteristic signal shape – Do the samples peak at the expected wavelengths? 
For example, samples containing only FAM™ dye-labeled TaqMan® probes should 
not produce raw fluorescence in the wavelength of a VIC® dye component. A signal 
present in wells that do not contain the dye could indicate that the sample, master 
mix, or well contains contaminants.

• Characteristic signal growth – As you drag the bar through the PCR cycles, do 
you observe growth as expected? Absent growth curves may indicate a pipetting 
error (for example, well lacks template) or no amplification.

• Signal Plateaus – Do any of the signals plateau? Signal plateaus or saturation can 
be an indication that a well contains too much template or fluorescent signal.

Passive Reference drop-down list 

Select the appropriate 
passive reference 
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Multicomponent
Plot

The Multicomponent Plot displays a plot of normalized multicomponent data from a 
single well of a real-time run. The plot displays the component dye signals that 
contribute to the composite signal for the well.

What to look for:

• Correct dyes displayed – Does the plot display all dyes as expected? The presence 
of an unexpected dye may be the result of an error in detector setup, such as 
assigning the wrong reporter or quencher dye.

• ROX dye fluorescence level – Does the ROX dye signal fluoresce below the 
reporter dyes? If not, the lack of reporter fluorescence may be caused by an absence 
of probe in the well (a pipetting error).

• Background fluorescence – Do all dyes fluoresce above the background? The 
Background signal is a measure of ambient fluorescence. If a dye fails to fluoresce 
above the background, it is a strong indication that the well is missing probes 
labeled with the dye (well does not contain probe, PCR master mix, or both).

• MSE Level – The MSE (mean squared error) is a mathematical representation of 
how accurately the multicomponented data fits the raw data. The higher the MSE 
value, the greater the deviation between the multicomponented data and the raw 
data.

Amplification Plot The Amplification plot displays data from real-time runs after signal normalization and 
Multicomponent analysis. It contains the tools for setting the baseline and threshold 
cycle (CT) values for the run.

What to look for:

• Correct baseline and threshold settings – Are the baseline and threshold values 
set correctly? 
Identify the components of the amplification curve and set the baseline so that the 
amplification curve growth begins at a cycle number that is greater than the highest 
baseline number. 
Identify the components of the amplification curve and set the threshold so that it is:
– Above the background 
– Below the plateaued and linear regions
– Within in the geometric phase of the amplification curve

IMPORTANT! After analysis, you must verify that the baseline and threshold were 
called correctly for each well by clicking on the well in the Plate Grid and viewing 
the resulting plots. For more information about manually adjusting the baseline and 
threshold settings, refer to the SDS Online Help.

• Irregular amplification – Do all samples appear to have amplified normally? The 
three phases of the amplification curve should be clearly visible in each signal. 
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• Outlying amplification – When the run data is viewed in the CT vs. Well Position 
plot, do replicate wells amplify comparably? Wells producing CT values that differ 
significantly from the average for the associated replicate wells may be considered 
outliers.
If a plate produces non-uniformity between replicates, some samples on the plate 
could have evaporated. Check the seal of the optical adhesive cover for leaks.

Allelic Discrimination and Plus/Minus End-Point Assay Runs

Troubleshooting
Analyzed Data

When faced with irregular data, you can use the SDS software to diagnose some 
chemistry- and instrument-related problems. The following table contains a summary of 
checks for verifying the integrity of your run data and to help you begin troubleshooting 
potential problems.

Raw Data The Raw Data Plot displays the raw reporter fluorescence signal (not normalized) for the 
selected wells during each cycle of the PCR. 

What to look for...

• Signal tightness and uniformity – Do the raw spectra signals from replicate 
groups and controls exhibit similar spectral ‘profiles’? If not, the plate or sample 
block could be contaminated.

• Characteristic signal shape – Do the samples peak at the expected wavelengths? 
For example, samples containing only FAM dye-labeled TaqMan probes should not 
produce raw fluorescence in the peak wavelength of the VIC dye component. A 
signal present in wells that do not contain the dye could indicate that the sample, 
master mix, or well contains contaminants.

• Signal Plateaus – Do any of the signals plateau? Signal plateaus or saturation can 
be an indication that a well contains too much template or fluorescent signal.
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Using Flags

Flags and
Troubleshooting

Version 2.3 of the Sequence Detection Systems (SDS) Software features a system of flags 
that provide the basis for algorithmically identifying and eliminating problematic data 
from plate document and RQ study analysis. The flags are application-specific metrics, 
where each evaluates the data for a specific quality that is consistent with a problem 
common to a supported analysis. The system is designed to allow you to automatically 
exclude questionable data, alert you to potential problems, and provide you with a starting 
point for investigation.

About Flags Each flag is the result of a unique algorithmic test that evaluates a specific property of the 
plate document data. The software performs the tests in a specific sequence and completes 
the analysis of the plate document even if one or more wells is flagged. Every flag yields a 
pass/fail result that indicates the success of the associated test. If a flag is enabled, the 
software indicates the status of the test in the appropriate column of the Results Table, as 
follows:

• A ✔ for a well that is flagged (Fail)
• Blank for a well that is not flagged (Pass)

In the SDS Software, you can automatically flag results data to meet specified criteria. Flags 
are assay specific and are user configured or automatically assigned.

• Automatically assigned flags are not user configurable. These flags are displayed in 
the Results table and the QC Summary tab.

• User configured flags are set/defined by the user. These flags are also displayed in 
the Results table and QC Summary tab.

Flag Symbols

Following an analysis, the software summarizes the results of the flag metrics for each 
sample by displaying one of four symbols. These symbols appear in the Flag column of 
the Results Table and in the Plate Grid.

Note: Applied Biosystems recommends examining all samples that are flagged.

Symbol Definition

 
The sample passed all applicable flag tests (Pass).

One or more possible problems exists for the associated sample (Fail). 

Note: The symbol displays the number of flags the sample failed.

Omitted Well: Well omitted automatically by the algorithm

Note: The symbol displays the number of flags the sample failed.

Omitted Well: Well omitted manually by user

2

1
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Customizing Flags 

Most flags are a measurement of a specific aspect of the sample data. A flag is produced 
when the measurement exceeds a threshold, some of which you can customize to refine 
your analyses. In these cases, the user-defined parameters for the flags appear in the 
Analysis Settings dialog box for the applicable analysis type. See “Configuring Flags for 
Use” on page 129 for more information on entering custom thresholds.

Notes for Using
Flags

• Flags appear in the results tab, the plate grid, and the QC Summary tab.
• Flags are warnings. The software does not stop the analysis if one or more samples 

fail the flag tests. 
• Applied Biosystems recommends examining flagged results (✔).
• Holding the cursor over a column header in the Results Table displays a tooltip that 

lists the full name of the column (the default names are often acronyms).

Configuring
Flags for Use

While viewing the desired plate document or relative quantitation (RQ) study:

1. Click  to display the Analysis Settings dialog box.

2. In the Analysis Settings dialog box, select the Plate tab (or select the Study tab if 
you are configuring the settings for an RQ study).

3. Using the table on page 130 as a reference, do the following for each row in the 
Flag Condition and Omit Settings table:

a. If you want the software to display the results of the flag in the Results Table, 
select the check box in the Flag Condition column.

b. Do not change the qualifying statement in the Condition column.
c. In the Flag Condition Value column, enter a value for the software to apply as 

the threshold or limit for the associated flag.
d. If you want the software to omit the wells that fail the flag from the analysis, 

select the check box in the Omit column.
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4. If you want the software to apply the current settings to all future plate documents 
of the same analysis type, select Save Settings As My Default.

5. Click Apply to reanalyze the plate document or study without closing the Analysis 
Settings dialog box, or click OK.

Flags By Analysis

Note: The plus/minus plate documents do not feature a system of flags.

Flags for SDS Software Version 2.3
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Study

BAF Baselining algorithm failed ✔ ✔ 132

BPR Bad passive reference signal ✔ ✔ ✔ ✔ ✔ 132

CAF CT calculation algorithm failed ✔ ✔ 133

DCN The distance between cluster and 
NTCs is

✔ ✔ 133

EAF Exponential region algorithm failed ✔ ✔ 133

EW A well is empty ✔ ✔ ✔ ✔ ✔ 134

FOS Fluorescence is off-scale ✔ ✔ ✔ ✔ ✔ 134

GBO Well is an outlier ✔ ✔ 139

HMD A well has missing data ✔ ✔ ✔ ✔ ✔ 136

HNS A well has a noise spike ✔ ✔ ✔ ✔ 136

HRN A well has high relative noise ✔ ✔ ✔ ✔ 136

HSD High standard deviation in replicate 
group

✔ ✔ 137

HW Hardy Weinberg value is ✔ ✔ 135

LME Large mean squared error is ✔ ✔ ✔ ✔ ✔ 137

LPL Laser power is low during the run ✔ ✔ ✔ ✔‡ 138

NAP Percentage of plate wells not amplified ✔ ✔ ✔ ✔‡ 138
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NAW A well is not amplified ✔ ✔ ✔ ✔ 138

NOC Number of clusters is ✔ ✔ 139

POU Percentage of outliers is ✔ ✔ 139

SNS The number of samples is ✔ ✔ 139

TAF Thresholding region algorithm failed ✔ ✔ 140

‡ Visible only when viewing study data using the Plate Centric Table Orientation.

Flags for SDS Software Version 2.3
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Description of Flags

Baselining Algorithm Failed (BAF)

Description/
Function

This flag indicates that the algorithm was unable to determine the best fit baseline for the 
data set.

Note: The Exponential Region, Baselining, Thesholding, and CT Calculation 
Algorithms are performed in sequence. If one flag fails, then the SDS software does not 
compute the flags for the remaining algorithms in the sequence.

Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. In the Amplification Plot, review the amplification curves. If necessary, set the 
baseline and threshold manually for the affected data.

Bad Passive Reference (BPR)

Description/
Function

This flag indicates that the passive reference signal for the associated sample may: 

• Be below normal levels
• Contain irregular fluctuations (non-uniform signal) 

Troubleshooting 1. Confirm the results of the flag test:
a. Select the affected sample in the Results Table. 
b. Select the Results tab.
c. Click  to display the Multicomponent Plot.
d. In the Multicomponent Plot, review the passive reference signal for 

irregularities. 

2. If the passive reference signal does contain inconsistencies, determine the location 
of the failed well in the Results Table. 

3. If the plate or TLDA used to run the sample is available, verify that the well 
contains fluid.
Fluctuations in the passive reference signal can be caused by:

• An empty or leaking well
• Formation of bubbles in the well
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4. If the passive reference signal does not exhibit inconsistencies or abnormal 
behavior, consider changing the analysis settings for the flag to be less sensitive.

CT Calculation Algorithm Failed (CAF)

Description/
Function

This flag indicates that the software could not calculate a CT because of a computational 
error. 

Note: The Exponential Region, Baselining, Thesholding, and CT Calculation 
Algorithms are performed in sequence. If one flag fails, then the SDS software does not 
compute the flags for the remaining algorithms in the sequence.

Troubleshooting 1. Select the affected sample in the Results Table.

2. Select the Results tab.

3. In the Amplification Plot, review the amplification curves. If necessary, set the 
baseline and threshold manually for the affected data.

Distance Between Cluster and NTCs (DCN)

Description/
Function

This flag indicates that the associated sample is located close to the no template control 
(NTC) cluster, and may not have amplified well. If active, the SDS software omits all 
samples that do not meet condition criteria. 

Troubleshooting Insufficient signal may be the result of poor PCR or an insufficient number of 
thermocycles.

Exponential Region Algorithm Failed (EAF)

Description/
Function

This flag indicates that the software could not identify the exponential region of the 
amplification curve. 

Note: The Exponential Region, Baselining, Thesholding, and CT Calculation 
Algorithms are performed in sequence. If one flag fails, then the SDS software does not 
compute the flags for the remaining algorithms in the sequence.

Troubleshooting 1. Select the affected sample in the Results Table.

2. Select the Results tab.
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3. In the Amplification Plot, review the amplification curves. If necessary, set the 
baseline and threshold manually for the affected data.

Empty Well (EW)

Description/
Function

This flag indicates that the software has determined the associated well to be empty 
because the well:

• Does not contain sample or reagents (primers and TaqMan® probes).
• Produced very low fluorescence (or none at all)

Troubleshooting 1. Confirm the results of the flag test:
a. Select the affected sample in the Results Table. 
b. Select the Results tab.
c. Click  to display the Multicomponent Plot.
d. In the Multicomponent Plot, verify that the signals are below normal level for 

the plate/study.

2. In the Results Table, determine the location of the failed well.

3. If the plate or TLDA used to run the sample is available, verify that the well 
contains fluid. 

Fluorescence Off-Scale (FOS)

Description/
Function

This flag indicates that the associated sample produced fluorescence in one or more 
cycles that exceeds the maximum detectable range for the 7900HT instrument 
(CCD saturation).

Note: Offscale data can corrupt the results of a run if the offscale data is located at a 
cycle that interferes with the CT calculation.

Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. Click  to display the Multicomponent Plot.

4. In the Raw Data and Multicomponent Plots, evaluate the effect of the offscale data. 
Does the offscale data interfere with the CT calculation? If so, consider omitting the 
well from the analysis.
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5. If possible, determine the source of the offscale result. 
A variety of factors can produce offscale data including: 

• Sample Overload – High concentrations of sample can produce offscale data. 
• Contamination – A fluorescent contaminant on the exterior a well or within the 

reaction can produce consistently high signals throughout a run. 

Outlier Well (GBO)

Description/
Function

This flag indicates that the CT of the sample deviates significantly from those of the 
associated replicate group and has been identified as an outlier based on the Grubbs test 
(also known as the extreme studentized deviate [ESD] method for outlier removal).

Note: The algorithm does not remove samples that achieve CTs within 0.25 of the mean 
for the replicate group.

Note: If two sample produce identical CTs but are identified as outliers, then the 
software flags both wells.

Troubleshooting 1. In the SDS RQ Manager Software, note the well positions of the outlier and 
associated replicates.

2. Select Table Orientation Detector Centric.

3. In the upper-left pane, select the detector that the outlier evaluates to view the data 
for the replicate group.

4. Select the Amplification Plot tab, then select Data Ct vs. Well Position to view 
the clustering of the CTs for the replicate group.

5. Evaluate the outlier. Omit or restore the well as necessary.

Hardy Weinberg Value (HW)

Description/
Function

This flag identifies samples that belong to a population that does not match Hardy 
Weinberg equilibrium.

Troubleshooting The samples may trigger this flag as a result of genuine allelic disequilibrium in the 
associated population or because of several experimental and technical issues.
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Has Missing Data (HMD)

Description/
Function

This flag indicates that the associated sample contains one or more cycles for which no 
spectral data is present. 

Note: Although rare, samples can contain missing data as the result of an interruption to the 
7900HT instrument hardware or software during the run.

Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. Click  to display the Multicomponent Plot.

4. In the Raw Data and Multicomponent Plots, observe the missing data. 
Does the missing data interfere with the CT calculation? If so, consider omitting the 
well from the analysis.

Has Noise Spike (HNS)

Description/
Function

This flag indicates that the amplification curve contains one or more abnormal data 
points which are inconsistent with the rest of the curve. 

Troubleshooting 1. Select the affected sample in the Results Table.

2. Select the Results tab.

3. In the Amplification Plot, review the amplification curves for the noise spike. If the 
noise spike has biased the baselining or CT calculations, consider omitting the well 
from the analysis or set the baseline and threshold manually for the affected data.

4. If no noise spikes are present, change the analysis settings for HNS to be less 
sensitive.

High Relative Noise (HRN)

Description/
Function

This flag indicates that the associated sample failed the high relative noise test. 

The algorithm determines the magnitude of the noise for each well based on the reporter 
dye signal. It also estimates the mean and standard deviation of the noise for the entire 
plate. The flag is evaluated by comparing the noise of the well to the plate, then 
determining whether or not it exceeds the threshold in the analysis settings.
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Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. Click  to display the Multicomponent Plot.

4. In the Multicomponent Plot, observe the signal corresponding to the background 
fluorescence. If necessary, omit the well.

5. Change the analysis settings to increase or decrease sensitivity, as desired.

High Standard Deviation in Replicate Group (HSD)

Description/
Function

This flag indicates that the standard deviation of the CTs for the replicate group exceeded 
the criteria defined in the “High standard deviation in a replicate group” row of the Study 
tab in the Analysis Settings dialog box.

Troubleshooting 1. In the SDS RQ Manager Software, note the well positions within the outlier and 
associated replicates.

2. Select Table Orientation Detector Centric.

3. In the upper-left pane, select the appropriate detector to view the relevant data for 
the replicate group.

4. Select the Amplification Plot tab, then select Data Ct vs. Well Position to view 
the clustering of the CTs for the replicate group.

5. Evaluate the CT of the flagged well in relation to the replicates. Omit or restore the 
well as necessary.

Large Mean Squared Error (LME)

Description/
Function

This flag indicates that the associated sample failed the Mean Squared Error test. To 
perform the test, the software compares the maximum value for the mean squared error 
for the well to the criteria defined in the “Large Mean squared error is” row the Analysis 
Settings dialog box. If the statement evaluates True, then the software flags the well.

Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. Click  to display the Multicomponent Plot.
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4. In the Multicomponent Plot, observe the MSE curve in the plot. 
Factors that can produce a Large Mean Squared Error include: 

• Improper Pure Dye Calibration
• Incorrect dyes specified in setup
• Offscale fluorescence

Laser Power Low (LPL)

Description/
Function

This flag indicates that the power supplied to the laser of the 7900HT instrument 
decreased below the acceptable level at least once during the associated run.

Note: Applicable only to runs performed with version 2.3 and later of the SDS 
Software. 

Troubleshooting Open the log file for the appropriate 7900HT Fast System and confirm the loss of power 
during the associated run. 

IMPORTANT! If the loss of laser power is consistent and is observed over multiple runs, an 
instrument component may be nearing the end of its life and require service or replacement.

Non-Amplified Plate (NAP)

Description/
Function

This flag indicates that the percentage of wells on the plate that did not amplify exceeded 
the threshold defined in the “Percentage of plate wells not amplified” row of the 
Analysis Settings dialog box.

Note: Empty wells are not included in the test.

Troubleshooting Review the data of the wells that failed to amplify (flagged as NAW).

Not Amplified Well (NAW)

Description/
Function

This flag indicates that the associated sample failed to amplify. To determine this, the 
algorithm calculates the difference between the signal at the beginning of the run and the 
signal at the end of the run.

Applied Biosystems recommends using the default setting for the NAW calculation. To 
customize the setting, perform successive analyses of your data set using different 
settings and adjust the setting according to the desired sensitivity.
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Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. Observe the signals in the Amplification Plot. If necessary, omit the well.

Number of Clusters (NOC)

Description/
Function

This flag indicates that the number of clusters in the data set (excluding the NTC cluster) 
is outside the threshold range defined in the “Number of clusters is” row of the Analysis 
Settings dialog box.

Troubleshooting 1. Select the affected sample in the Results Table. 

2. Select the Results tab.

3. In the Allele Plot, observe the data point in relation to the related cluster. If 
necessary, omit the well.

Percentage of Outliers (POU)

Description/
Function

This flag indicates that the percentage of outliers on the plate exceeds the threshold 
defined in the “Percentage of outliers is” row of the Analysis Settings dialog box.

Small Number of Samples in Cluster (SNS)

Description/
Function

This flag indicates that the number of data points in the cluster is less than the threshold 
defined in the “The number of samples is” row of the Analysis Settings dialog box. 

The software can flag wells as the result of:

• Low allele frequency
• Small sample population
• Outliers mistakenly identified as a cluster (one or two samples in a cluster may in 

fact be an outlier) 

Troubleshooting Review the calls and/or re-run the plate.
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Thresholding Algorithm Failed (TAF)

Description/
Function

This flag indicates that the software could not calculate a threshold because of a 
computational error. 

Note: The Exponential Region, Baselining, Thesholding, and CT Calculation 
Algorithms are performed in sequence. If one flag fails, then the SDS software does not 
compute the flags for the remaining algorithms in the sequence.

Troubleshooting 1. Select the affected sample in the Results Table.

2. Select the Results tab.

3. In the Amplification Plot, review the amplification curves. If necessary, set the 
baseline and threshold manually for the affected run.
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Adding Custom Dyes to the
Pure Dye Set

The Applied Biosystems 7900HT Fast Real-Time PCR System can be used to run assays 
designed with custom dyes (dyes not manufactured by Applied Biosystems). However, 
before using custom dyes with the 7900HT Fast System, you must create and run a pure 
dye plate made with the custom dyes. The purpose of the custom pure dye plate is 
similar to that of a standard pure dye plate: the SDS software uses the custom pure dye 
plate to create a spectral standard to distinguish the custom dye.

IMPORTANT! To use a custom dye on your 7900HT Fast System, it must fluoresce 
within the spectral range measured by the instrument. The working range of the CCD 
camera is 500 to 660 nm.

Before You Begin

Materials
Required

You need the materials listed below to perform this procedure.

Powder-free gloves and safety goggles

Reaction plates appropriate for your sample 
block:

• Standard 384-well reaction plates

• Standard 96-well reaction plates

• Fast 96-well reaction plates

Note: You cannot create custom dyes for 
the TaqMan® Low Density Array Block.

Pipettors and pipet tips (100-µL)
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Water, deionized

Custom dyes

Tubes (2-mL and 10-mL)

Optical adhesive covers or Optical Caps 
(PN 4323032)

Centrifuge, with plate adapter



Appendix A
Before You Begin

7900HT Fast System Maintenance and Troubleshooting Guide 143

Notes

Workflow To add custom dyes to the pure dye set:

1. Obtain the tools and materials required (see pages 141 and 142).

2. Create a dilution series plate for each custom dye you want to add to the pure dye 
set (see page 144).

3. Create a plate document for the dilution series plate (see page 144).

4. Run and analyze the dilution series plate (see page 145).

5. Create a pure dye plate with the custom dye(s) (see page 148).

6. Add the custom dye(s) to the SDS software (see page 149).

7. Create a plate document template with the custom dye(s) (see page 150).
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Creating a Dilution Series Plate
1. In the center wells of a reaction plate, prepare a 

dilution series of the custom dye (for example 
25, 50, 100, 200, 400, 800, 1600, and 3200 nM 
concentration):

• For a standard 384-well or Fast 96-well 
reaction plate, use 20 µL per well

• For a standard 96-well reaction plate, use 
50 µL per well

2. Seal the wells of the reaction plate using an 
optical adhesive cover or Optical Caps 
(PN 4323032).

IMPORTANT! Do not use MicroAmp® caps 
(domed) or Optical Tubes with the 7900HT Fast 
System. You can use Optical Caps (PN 4323032) 
(ONLY on the standard 96-well reaction plates) 
with the 7900HT Fast System.

3. Repeat this procedure for each custom dye you 
wish to add to the pure dye set.

Creating a Plate Document for the Dilution Series Plate

1. Double-click  on the desktop (or select Start 
> All Programs > Applied Biosystems > SDS 
2.3 > SDS 2.3) to start the SDS software.

2. If the login option is enabled, the Login dialog 
box appears. Enter your User Name and 
Password, then click OK.

Note: If the login option is not enabled, no 
Login dialog box appears. Skip to step 3 below.

3. From the SDS software menu bar, click  (or 
select File New).
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4. Complete the New Document dialog box: 
a. Assay – Select Allelic Discrimination.
b. Container – Select the appropriate format.
c. Template – Select Blank Template.
d. Barcode – Leave this field blank.
e. Click . The software creates and 

opens a new plate document. 

Note: It is not necessary to configure detector, 
sample, or method information for the dilution 
series plate document. The purpose of the run is 
to establish the correct working concentration for 
the dye by viewing the intensity of the raw 
spectra produced by the wells in the dilution 
series.

5. Repeat this procedure for each dilution series 
plate you created.

Running and Analyzing the Dilution Series Plate

1. In the plate document, select the Instrument > 
Plate Read tabs.

2. Click Open/Close. The instrument tray rotates to 
the OUT position.

4a

4b

4c

4d
4e
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3. Place the prepared series dilution plate into the 
instrument tray as shown.

IMPORTANT! The A1 position is located in the 
top-left side of the instrument.

4. Click Post Read. The instrument tray rotates to 
the IN position and the instrument performs the 
run.
As the instrument performs the run, it displays 
status information in the Plate Read tab.
After the run, the status values and buttons are 
grayed-out, the Analysis button is enabled ( ), 
and a message indicates whether or not the run is 
successful.

5. Click Open/Close to eject the reaction plate.

6. Click  (or select Analysis Analyze). The 
software analyzes the raw run data.

7. Click  (Show System Raw Data Pane).

Well A1

Barcode

Standard 384-well reaction plate
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8. In the Raw Data Plot, determine the highest 
concentration of dye that does not produce a 
saturated signal, then record it for future use.

Saturated signals are characterized by their high 
peaks that rise beyond detectable levels 
(> 65,000 fluorescent units) and appear as 
plateaus on the Raw Data plot.
The concentration of the custom dye that yields 
the highest possible signal but does not saturate 
is the maximum concentration for use with the 
7900HT Fast System.

9. Repeat this procedure for each dilution series 
plate you created.
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Creating a Pure Dye Plate with the Custom Dye(s)

1. Prepare 5 mL of a custom dye at the 
concentration determined in step 8 on page 147.

2. Pipet the diluted custom dye to at least three 
columns of a reaction plate, as shown at right.

IMPORTANT! The optical configuration of the 
7900HT instrument requires that each custom 
dye occupy at least three columns of the reaction 
plate to permit adequate data collection.

• For a standard 384-well or Fast 96-well 
reaction plate, pipet 20 µL per well

• For a standard 96-well reaction plate, pipet 
50 µL per well

3. Repeat steps 1 through 2 for each custom dye 
you wish to add to the reaction plate.

4. Seal the wells of the reaction plate using an 
optical adhesive cover or Optical Caps 
(PN 4323032).

IMPORTANT! Do not use MicroAmp® caps 
(domed) or Optical Tubes with the 7900HT Fast 
System. You can use Optical Caps (PN 4323032) 
(ONLY on the standard 96-well reaction plates) 
with the 7900HT Fast System.
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Adding the New Custom Dye(s) to the SDS Software
1. From the SDS software menu bar, select 

Tools > Dye Manager.

2. In the Dye Manager dialog box, click .

3. In the Add Dye dialog box:
a. Enter a name for the custom dye.
b. Click . The new dye appears in the 

Dye Manager’s Custom dye list.

4. Repeat steps 1 through 3 for each custom dye 
you added to the custom pure dye plate 
(page 148).

5. Click . The SDS software makes the new 
dye(s) available to pure dye plate documents. 

3a
3b
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Creating a Plate Document Template with the Custom Dye(s)

1. Click  (or select File New).

2. Complete the New Document dialog box: 
a. Assay – Select Pure Spectra.
b. Container – Select the appropriate format.
c. Template – Select Blank Template.
d. Barcode – Leave this field blank.
e. Click . The software creates and 

opens a new plate document.

3. Apply the new custom dye(s) to the plate 
document:

a. Select the wells containing the first custom 
dye.

b. Select the Setup tab.
c. In the Dyes drop-down list, select the 

appropriate dye. The software applies the 
dye to the selected wells.

d. Repeat steps a and b to configure the plate 
document with any additional custom dyes.

2a

2b

2c

2d

2e

Custom dye added to 
selected wells of the 
plate document

3c

3b
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4. Save the custom pure dye plate document as a 
plate document template:

a. Click  (or select File > Save) to open the 
Save As dialog box.

b. In the Save in field, navigate to and open 
AppliedBiosystems SDS2.3
Templates.

Note: By saving the plate document 
template to the Templates directory, it 
becomes available from the Template drop-
down list in the New Document dialog box.

c. In the File name field, enter a name for the 
plate document template.

d. Select SDS 7900HT Template Document 
(*.sdt) from the Files of type drop-down 
list.

e. Click . The software saves the plate 
document as a plate document template.

5. To run the custom dyes, see “Performing a Pure 
Dye Calibration” on page 17.

4b. This should be 
Templates

4e
4c

4d
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Instrument Connections

Electrical
Connections

Figure B-1 and Table B-1 illustrate the electrical connections of the Applied Biosystems 
7900HT Fast Real-Time PCR System components.

Figure B-1 Connections of the 7900HT Fast System

HI-POT

A B C D

HI-POT

A B C D

G
R

2
0
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0

Communications Cable

C

Power

Power

Power

G

G

H

Power Cable

A

C

EPower

D B

A E

Table B-1 Connections of the 7900HT Fast System

Cable Type Connects… To…

A Communication Computer (Monitor Port) Monitor

B Comm/Power Computer (Mouse Port) Mouse (not shown)

C Serial Computer (Serial Port 1) 7900HT Instrument

D Comm/Power Computer (Keyboard Port) Hand-held Bar Code Reader

E Communication Computer (Serial Port 2) Plate Handler (Port C)

G‡

‡See Figure B-2 on page B-154.

Comm/Power Computer (ISA Card 1) Fixed-Position Bar Code Reader 

H Comm/Power Bar Code Reader Cable Keyboard (not shown)
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Fixed-Position
Bar Code Reader

Figure B-2 Fixed-position bar code reader connection

Figure B-3 Universal power strip

To install the Universal Voltage Accessory Kit (All Countries Except Japan):

1. Connect one universal jumper to each accessory (see below for use in Japan).

2. Connect the other end of the power jumpers to the power strip outputs.

3. Choose the correct country specific power input cord for the geographical region 
and connect it to the power strip input.

4. Power off all instrument accessories (monitor, computer, and Plate Handler).

5. Connect the power-input cord to the AC outlet.

Power

Power supply

G

To Lava Card 
(ISA Card 1)Bar Code 

Reader Cable

IEC 320 4-Position 
Universal Power Strip 
(PN 4333969)

North America: 120V@15A MAX
Europe and all other locations: 250V@10A MAX

To computer, monitor, hand-held bar code 
reader, and the Plate Handler

Note: The order is not critical.

Universal Voltage
Accessory Kit
(P/N 4334482)

Universal Jumper Cord set × (4) 

Jumper Cord set for Japan × (4)
(see below for use in Japan)

IEC 320 North America × (1)

IEC 320 Continental Europe × (1)

IEC 320 U.K./Ireland × (1)

IEC 320 Australia/ 
New Zealand × (1)

IEC 320 Japan × (1)
In Bag Marked “JAPAN ONLY”
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6. Power on accessories.

7. Discard unused cord sets.

Usage Guidelines for Japan

1. Use only the cord sets supplied in the bag marked “JAPAN ONLY.”

2. Discard all other unused cord sets.
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Parts and Consumables

Note: Part numbers listed in this appendix are for customers inside the United States. 
Contact your Regional Sales Office for local Part numbers and prices. See “How to 
Obtain Support” on page vii.

Interchangeable Sample Block Modules and Accessories
The Applied Biosystems 7900HT Fast Real-Time PCR System features a Peltier-based, 
interchangeable sample block based on the technology established in the GeneAmp® 
PCR System 9700 thermal cycler.

The use of an interchangeable sample block:

• Reduces instrument downtime by allowing immediate replacement of the block.
• Permits easy access to the sample block for troubleshooting and maintenance. 
• Supports multiple consumable formats. 
• Provides several different modes of operation (including Max mode and 

programmable temperature ramps).

Table C-1 Sample block modules and accessories

Part No. Description Quantity

4331406 7900HT System Standard 384-Well Block Upgrade Kit

Includes a Standard 384-Well Block, a 384-Well Plate Adapter, 
and a Sequence Detection Systems 384-Well Spectral Calibration 
Kit (PN 4323977)

1 kit

4331405 7900HT System Standard 96-Well Block Upgrade Kit

Includes a Standard 96-Well Block, a 96-Well Plate Adapter, and 
an ABI PRISM® 7900HT Sequence Detection Systems 96-Well 
Spectral Calibration Kit (PN 4328639)

1 kit

4351402 7900HT System Fast 96-Well Block Upgrade Kit

Includes a Fast 96-Well Block, a Fast 96-Well Plate Adapter, a 
7900HT System Fast 96-Well Spectral Calibration Kit 
(PN 4351653), a TaqMan® RNase P Fast 96-Well Instrument 
Verification Plate (PN 4351979), and a TaqMan® Fast Reagents 
Starter Kit (PN 4352407)

1 kit
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Consumables and Disposables
The 7900HT Fast System can run:

• 384-Well Optical Reaction Plates (also referred to as standard 384-well reaction 
plates) sealed with optical adhesive covers

• MicroAmp® 96-Well Optical Reaction Plates (also referred to as standard 96-well 
reaction plates) sealed with optical adhesive covers or Optical Caps (PN 4323032, 
flat cap strips only)

• Optical 96-Well Fast Thermal Cycling Plates (also referred to as Fast 96-well 
reaction plates) sealed with optical adhesive covers

• TaqMan® Low Density Arrays

The optical plates recommended above are designed specifically for fluorescence-based 
PCR chemistries and are frosted to minimize external fluorescent contamination. Before 
running prepared optical plates on the 7900HT instrument, each plate must be sealed 
with the optical adhesive covers recommended above. Applied Biosystems optical 
adhesive covers are specifically designed to permit the transmission of light to and from 
the wells of the optical plate.

IMPORTANT! Do not use MicroAmp® caps (domed) or Optical Tubes with the 
7900HT Fast System. You can use Optical Caps (PN 4323032) (ONLY on the standard 
96-well reaction plates) with the 7900HT Fast System.

4329012 7900HT System TaqMan® Low Density Array Upgrade

Includes a TaqMan® Low Density Array Block, microfluidic card 
sealer, centrifuge buckets and adapters, and a chemistry 
installation kit.

1 kit

Table C-1 Sample block modules and accessories (continued)

Part No. Description Quantity

Table C-2 Consumables and disposables for the 7900HT instrument

Part No. Description Quantity

Optical Adhesive Covers

4313663 ABI PRISM® Optical Adhesive Cover Starter Kit

Includes 20 ABI PRISM® Optical Adhesive Covers, an Applicator, 
and an ABI PRISM® Optical Cover Compression Pad.

20 Covers

4311971 ABI PRISM® Optical Adhesive Covers 100 Covers

4360954 Optical Adhesive Covers 25 Covers
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 4323032 Optical Caps, 8 Caps/Strip 300 Strips/ 
Pkg

2400 Caps/ 
Pkg

Standard 384-Well Reaction Plates

4309849 384-Well Clear Optical Reaction Plate with Barcode (code 128) 50 Plates

4326270 384-Well Clear Optical Reaction Plate with Barcode (code 128), 
10-Pack

Includes 10 of PN 4309849, 384-Well Clear Optical Reaction 
Plates with Barcode

500 Plates

Standard 96-Well Reaction Plates

4306737 MicroAmp® 96-Well Optical Reaction Plate with Barcode (code 
128)

20 Plates

4326659 MicroAmp® 96-Well Optical Reaction Plate with Barcode (code 
128), 25-Pack

Includes 25 of PN 4306737, MicroAmp® 96-Well Optical Reaction 
Plates with Barcode

500 Plates

4314320 MicroAmp® 96-Well Optical Reaction Plate with Barcode (code 
128) and ABI PRISM® Optical Adhesive Covers

Includes 100 ABI PRISM® Optical Adhesive Covers (PN 4311971) 
and 5 of PN 4306737, MicroAmp® 96-Well Optical Reaction Plates 
with Barcode

100 Plates

100 Covers

4312063 MicroAmp® Splash Free Support Base for 96-Well Reaction 
Plates

10 Bases

Fast 96-Well Reaction Plates

4346906 Optical 96-Well Fast Thermal Cycling Plate with Barcode (code 
128)

20 Plates

4312063 MicroAmp® Splash Free Support Base for 96-Well Reaction 
Plates

10 Bases

TaqMan® Low Density Arrays

--- TaqMan® Low Density Arrays Variable*

* See the Applied Biosystems Web site.

Table C-2 Consumables and disposables for the 7900HT instrument (continued)

Part No. Description Quantity
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Instrument Maintenance and Verification
The following sequence detection kits and reagents are used to perform routine 
maintenance on and verify the function of the 7900HT Fast System.

Table C-3 Consumables for calibration and verification runs

Part 
Number Description Quantity

Sequence Detection Systems Calibration Kits

4328639 ABI PRISM® 7900HT Sequence Detection Systems 96-Well 
Spectral Calibration Kit 

Includes three MicroAmp® 96-Well Optical Reaction Plates: one 
preloaded and sealed background plate, and two preloaded and 
sealed pure dye plates containing eight separate dye standards 
(FAM™, JOE™, NED™, ROX™, SYBR® Green, TAMRA™, TET™, 
VIC®).

3 x 96-Well 
Plates

4323977 Sequence Detection Systems 384-Well Spectral Calibration Kit 

Includes two 384-Well Optical Reaction Plates: one preloaded and 
sealed background plate and one preloaded and sealed pure dye 
plate containing eight separate dye standards (FAM, JOE, NED, 
ROX, SYBR Green, TAMRA, TET, VIC).

2 x 
384-Well 

Plates

4351653 7900HT System Fast 96-Well Spectral Calibration Kit 

Includes three Optical 96-Well Fast Thermal Cycling Plates: one 
preloaded and sealed background plate, and two preloaded and 
sealed pure dye plates containing eight separate dye standards 
(FAM™, JOE™, NED™, ROX™, SYBR® Green, TAMRA™, TET™, 
VIC®).

3 x 96-Well 
Plates

4362745 TaqMan® Low Density Array Spectral Calibration Kit

Includes four empty TaqMan® Low Density Arrays (TLDAs) and 
four tubes: one background solution, one FAM™ dye, one 
ROX™ dye, and one VIC® dye.

4 x TLDAs

Instrument Verification Plates

4310982 TaqMan® RNase P Instrument Verification Plate

Includes one MicroAmp® 96-Well Optical Reaction Plate. Each 
well contains preloaded reaction mix (master mix, RNase P 
primers, and FAM™ dye-labeled probe) and template to detect 
and quantitate genomic copies of the human RNase P gene. 

1 x 96-Well 
Plate

4323306 TaqMan® RNase P 384-Well Instrument Verification Plate

Includes one 384-Well Optical Reaction Plate. Each well contains 
preloaded reaction mix (master mix, RNase P primers, and FAM™ 
dye-labeled probe) and template to detect and quantitate 
genomic copies of the human RNase P gene.

1 x 384-
Well Plate
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4351979 TaqMan® RNase P Fast 96-Well Instrument Verification Plate

Includes one Optical 96-Well Fast Thermal Cycling Plate. Each 
well contains preloaded reaction mix (master mix, RNase P 
primers, and FAM™ dye-labeled probe) and template to detect 
and quantitate genomic copies of the human RNase P gene. 

1 x 96-Well 
Plate

4351468 TaqMan® Low Density Array RNase P Kit

Includes one empty TaqMan® Low Density Array (TLDA) and eight 
tubes of solution. Each solution contains reaction mix (master mix, 
RNase P primers, and FAM™-MGB dye-labeled probe) and 
template to detect and quantitate genomic copies of the human 
RNase P gene.

1 TLDA

Table C-3 Consumables for calibration and verification runs (continued)

Part 
Number Description Quantity
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